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CHAPTER 1 - Introduction — 1-2

1.1 General Description

Program STABLPRO has been developed specifically for users to enter input data and to view
output graphics in the Microsoft Windows platform. The STABL programs (including STABL4,
STABL4M, STABLS5 and STABL5M) have been well accepted as useful tools for analyzing the stability
of slopes. However, the series adopts a command-line format for data entry which may be inconvenient
to infrequent users. Program STABLPRO enhances STABL program, a publicly available program
through Federal Highway Administration, with new computation functions, user-friendly features for data
entries, and graphics presentation of output results.

The current version - STABLPRO was written under the Microsoft Windows platform and uses the
enhanced-graphics interface to implement pull-down menus, dialog boxes, option buttons, and grid-cells
for data entry. The user may read information on the screen, then type input at the specified entry field.
The entered data can be changed freely by moving the mouse to the location of a particular field. The
graphics module allows the user to view failure surfaces, boundary lines, water surfaces, surcharge loads,
and other features.

The current version of STABLPRO allows the user to analyze a reinforced-earth slope . It also
allows either English units (ft and Ibs) or S.I. units (meter and kN) for computation. The program will
also help the user with unit conversions if the user has to change from one unit system to the other unit
system. The corresponded unit systems will be printed in the output file accordingly.

1.2 Background of the Program

Program STABL is a computer program written for the general solution of slope-stability problems
by a two-dimensional, limiting- equilibrium method. The original program of STABL was developed by
Ronald A. Siegel at Purdue University in 1975. STABL was placed on line for routine use in 1976 by the
Indiana Department of Highways, and after being reported in the open literature, the program began to be
adopted by many agencies.

However, due to more extensive use of STABL for teaching purposes, and also at the request of
users, STABL has been modified several times since it was introduced in 1975. The versions that are
recommended by Federal Highway Administration are STABL4, STABL4M, STABL5 and STABL5M.
STABL4 was developed by J. R. Carpenter in 1984 to handle tieback loading. STABLS5 differs from
STABLA4 in that STABLS5 includes the Spencer method of analysis. J. E. Thomaz and J. R. Verduin
further modified STABLS to introduce the Janbu coefficient and pore-pressure modifications in
STABL5M.

1.3 Features of the Program

Program STABLPRO was developed to improve the user-friendly features for Program STABL.
STABLPRO was written for Windows XP/Vista/7/8 platforms and uses a graphics interface for data
entry. The user may read the screen information, then type the data at the specified entry field. The
entered data can be changed freely by moving the mouse to the field location on the screen.

STABLPRO integrates the input modules, main-computation module, and graphics module into
one system. Therefore, the user may freely call on each module inside Windows for operation. In
general, after entering the input data , the user may use the computation module to execute the input data.
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The user may also call on the graphics module to plot the computed potential failure surfaces. The
concept of “a picture is worth a thousand words” is used to define most of the geometrically-related input
parameters.

Program STABL features unigue random techniques for generation of potential failure surfaces for
subsequent determination of the most critical surfaces and their corresponding factors of safety. One
technique generates circular failure surface, another technique generates general, irregular surfaces of
random shape. While the latest versions of the STABL group of programs are more versatile than the
earlier versions, all of the versions of Program STABL adopt the original command-line type of input
format which is inconvenient to infrequent users.

The extensive use of STABL for academic purposes generated requests from users to introduce
many improvements to the original STABL program since its introduction. The current version of
STABLPRO can handle tieback loading, reinforced-earth layers in embankment, and Spencer’s method of
analysis.

1.4 History of Development

1.4.1 STABLPRO1 (1995)

With the advent of wide-spread availability of personal computers, the founder of ENSOFT, Inc.,
had a vision to improve the engineering capability for analysis and design of deep foundations by
providing useful software tools. The development of STABLPRO1 was completed under the direction of
Dr. Lymon C. Reese and was first commercially distributed in 1987. While based on an earlier
mainframe program, STABLPRO1 was developed to use an interactive input method.

1.4.2 STABLPRO, Version 1 (1995)

STABLPRO v1.0 was released in 1995. The success of Windows 3.1 from Microsoft, Inc., as the
dominant platform for personal computers pushed software development to adopt a standard, graphical-
user interface. This first version of STABLPRO utilized Windows-based pre- and post-processors, while
retaining the original computing engine from STABL4M.

1.4.3 STABLPRO, Version 2 (1998)

This version of STABLPRO was a complete recoding of both the pre-and post-processing
programs running under Windows 95/NT and the computing engine. The windows-graphical-user
interface was rewritten to provide a more intuitive process for data input and to enhance the graphical
capabilities.

1.4.4 STABLPRO, Version 3 (2004)

This version of STABLPRO is upgraded for the requirement under Windows 2000/XP and the later
system. The most recent files of the input data will be listed under File Menu for users to load or retrieve
quickly and conveniently.

STABLPRO Version 3 add an option to analyze the reinforced-earth slope. The user-defined soil
layers and profile coordinates can be seen on the graphical windows for easy identification of any
mistakes in data entry.
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1.45 STABLPRO 2015, Version 4 (2015)

Program STABLPRO uses the year number as the version sequence starting in 2015, while keeping
the second number of the release equal to the input data format (input data format 4). The major
improvements in v2015.4 were a complete rewrite for a more intuitive interface under Windows 8
environment.

The new release also introduces many practical examples for users references. In addition, the
program text book was updated and released in separate User’s and Technical Manuals, both improved
plus released electronically in protected PDF format.

1.5 Organization of STABLPRO Manuals

The documentation provided with the computer program STABLPRO consists of two volumes.
The User’s Manual contains full documentation about the operation of the program on personal
computers. The User’s Manual covers the areas of installation, preparation of input data, program
execution, view of computational results, and example applications. The distribution of the User’s
Manual is made via standard Adobe© PDF file format.

The Technical Manual provides information about the theory and different methods used for slope
stability analyses. , The Technical Manual includes other helpful references related to concepts utilized in
program STABLPRO. The Technical Manual is distributed in protected form that can only be opened by
licensed users of the STABLPRO program.

Both Manuals are installed with the STABLPRO program and accessible via any one of the
following three methods: i) from the Windows Start Menu, ii) from the Ensoft tile in Windows 8, or iii)
from the Help menu within the STABLPRO program.

1.6 Typographical Conventions

To orient the user to different software features, certain terms are set in typefaces that distinguish
them from the body text. The following formatting conventions are used throughout the Manual:

e  Commands that are typed directly on the keyboard: “Enter” ; “F1”; “Esc”
e  Commands with keys simultaneously pressed in the keyboard: “Alt+F” ; “Ctr+O”
e  Menu items and other text displayed on the screen are in sans serif:
From the File menu choose Open
¢ File names and names of directories and folder and icon names are in italics:
Open the example file examplel.sfd
. Internet and electronic mail addresses are underlined:
Send email to support@ensoftinc.com

1.7 Contents of the STABLPRO Package

The standard package sent with STABLPRO consists of the following items:
e  One USB device (sometimes known as hardware key or dongle),

e one backup CD-ROM (this may be missing in future releases, since the full program is
available for free downloading from the www.ensoftinc.com website.
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The user-selected installation directory (default directory is Program
Files\Ensoft\STABLPRO2015) contains the main Windows-program module (winSTABLPRO2015.exe),
the program engine for direct computations (STABLPRO2015_DLL.dll), the Help file
(STABLPRO_2015.chm), and other support files. The User’s and Technical Manuals are also included in
the installation directory. Several examples of input files (all files with extension *.sl4d) are installed in a
separate Ensoft/STABLPRO2015-Examples subdirectory in the root Windows drive (usually c:\).

1.8 Hardware Requirements

To use STABLPRO, the user needs the following minimum hardware configuration:
e Any personal computer with an Intel® Pentium® or newer processor.
e  Ahard disk with at least 20 MB of free space.

e Microsoft Windows® 2000, XP, VISTA or Windows 7/8. A newer release of the Microsoft
Windows® operating system may need a more recent update of the STABLPRO software.

e Minimum of 2 GB of free RAM memory.
e A mouse or similar pointing device.
e  Optional: Any windows-compatible printer.

1.9 Technical Support

Although computer program STABLPRO was designed to be distinguished by its ease of use and
by its helpful User’s Manual, some users may still have questions. The technical staff at ENSOFT
strongly supports all registered users with questions related to the installation or use of STABLPRO,
according to the stipulations presented below. The software is provided with free maintenance service for
the first year. After the first year the user is encouraged to purchase the yearly maintenance services. The
yearly maintenance services include free download of the latest version and free technical support as
described below.

1.9.1 Preferred Methods of Software Support
Software support is given, in order of preference, by the following methods:
e  Electronic mail to: support@ensoftinc.com

e  Faxto: (512) 244-6067
e  Telephone call to: (512) 244-6464, extension 2

Users are strongly encouraged to utilize electronic means of support via email. In any event, users
should include the following information when requesting for software support: software version (obtain
from the Help/About menu), description of the problem copy, input-data file attachment, contact person
and licensed company or user name (or name and office location of the licensed company).

Although immediate answers (less than two hours during regular working hours) are offered on
most technical support requests, up to two business days should be expected in case of difficulties or
conflict of schedules. The users will be informed of ENSOFT’s reception of their electronic mails
requesting software support if the problem is complicated and cannot be resolved within two business
days.
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1.9.2 Support by Telephone

Technical help by means of direct calls to our local telephone number (512-244-6464) is available,
but limited. The current policy of ENSOFT is that all telephone calls for software support will be
answered free of charge for the first 15 minutes of each call if the user has a current maintenance policy.
A charge of $90.00 US dollars per hour ($1.50 US dollars per minute) may come into effect for every
additional minute after the initial 15 minutes. Applicable charges will be billed to the user.

Software support by any of the methods (fax, email or telephone) is free for all users that have a
current annual maintenance policy.

1.9.3 Upgrade Verification and Internet Site

Starting from STABLPRO v2015 the software provides options for the user to check the most
recent maintenance release through an internet connection by selecting Help/Check for Updates. This
command starts the default internet browser and will display the user’s maintenance expiration date, the
user’s software release number and the most recent release number that is available for downloading.

If the user’s version is not the latest version and the maintenance has not been expired, the user can
download the latest version from our web server directly (www.ensoftinc.com). Users may also consult
our internet site for additional information on software updates, demos, and new applications; technical
news; and company information.

1.9.4 Changes of Support Policy

The software support policy and associated expenses are subject to change at ENSOFT’s discretion
and without specific mailed notices to the users. However, any change of rules will be verbally provided
during telephone calls for software support.
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2.1 Installation Procedures

Program STABLPRO is distributed with an associated USB key (hardware key or dongle). The
hardware key consists of a device that is attached to an empty USB port (or USB hub) of the computer in
use (or in the designated software server in the case of local network licenses). This method of software
protection has been found to provide compatibility with existing operating systems, better stability than
other alternatives, and allows users to obtain software updates or replacements via downloads from the
internet.

2.1.1 Installation of Single-User Version

This version of STABLPRO has been tested to be compatible with the following versions of the
Microsoft Windows® operating systems: 2000, XP, Vista, Windows 7, 8 and 8.1.

The following guidelines are recommended to be followed during the installation process of
STABLPRO for single-user licenses.

1. Plug the supplied hardware lock (USB device) into one of the available USB ports in your computer.
The USB device is plug-and-play compatible so the operating system will recognize the USB device
automatically and a small solid green light should be noticeable at the end of the USB key (a
flickering green light or no light indicate problems with the standard windows driver or with the
USB key).

2. If the user installs from a distribution CD-ROM and the main installation program does not start
automatically upon insertion of the CD then click on the Windows Start Menu button and select
Run. On the command line, type d:\setup.exe or e:\setup.exe, where d: or e: represents the drive
that contains the distribution CD. Click OK to execute the command and start the main installation
program for ENSOFT’s software. A screen Similar to the one in Figure 2.1 should appear.

3. Ifthe user installs from a downloaded file then please run the downloaded file (double click) and go
to instruction #5.

4.  Click anywhere on the STABLPRO 2015 icon and then click on the Install Standard button to
start the installation of STABLPRO.

5. The user should read the license agreement shown in Figure 2.2. Please click Yes if you agree and
would like to proceed.

6. Select Single-User License in Figure 2.3 then click Next. For network installations please contact
Ensoft support (support@ensoftinc.com).

7. The user will be provided with an option to select a drive and directory for the installation of
STABLPRO (see Figure 2.4); the default is c:\Program Files (x86)\Ensoft\STABLPRO2015. If the
desired directory does not exist, the installation program will automatically create a new directory in
the chosen hard drive.

Most distribution files will be copied to the installation directory (either the default or the one
selected by the user). However, certain files are copied to system directories in Windows and some
Windows services are started during installation (mainly for Network installations). The name of the
system files, their exact locations, and the type of services that are started may change in time and
for different versions of the Microsoft Windows® operating system.
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Example files are copied to the following subdirectory under the root Windows drive:
(Root Drive)\Ensoft\STABLPRO2015-Examples

8. During the installation the user will be asked to set the file extension association for opening
STABLPRO 2015 input data files (see Figure 2.5). If the user agrees (leaves the default check mark)
then double clicking (or running) any input data file with extensions of the type filename.sl4d will
start the installed STABLPRO 2015 software.

9. The user will be prompted to confirm the shortcut directory name that will be created in the
Windows Start Menu (See Figure 2.6). The default is Start
Menu/Programs/Ensoft/STABLPRO2015. Windows 8 will automatically create an Ensoft tile with
the same shortcuts.

fE Ensoft, Inc. - CD ROM Installations = |[ = |[E2]
Flease selectthe program you wish to install

Lpile 2013 LPA Lra 3.0

% Group 2014 Setoff 3.0
i E™ i~

|

|

GeoMat 1.0

. Shaft 2012

€

2 Apile 2014 StablPro 2014
i (v
~ = Apile 2014 (Offshore) ~ DynaFile 2.0
TZpile 2.0 DynaMat 1.0
i = {~ y
PyWall 2013 DynaM 3.0
i {

Flease selectthe type of installation

[nztall Standard |

'ou must have the appropriate hardware lock to install full versions of our software

Figure 2.1 Main CD-ROM installation screen for ENSOFT software (may change with
time)
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After the installation is finished, it is not necessary to reboot Windows for the program to run. The
user may run the program by selecting STABLPRO v2015 from the standard links installed in the
Microsoft Windows® Start Menu: Start Menu > All Programs > Ensoft > STABLPRO2015

License Agreement

(2%

License Agreement

Please read the following license agreement carefully,
Press the PAGE DOWN key to see the rest of the agreement.

PROGRAM LICENSE AGREEMENT & DISCLAIMER. -
IMPORTAMT MOTICE: This License Agreement & Disclaimer (LICEMSE ) isa —
leqal agreement between you (either an individual or a single entity) and

Ensoft Incorporated (ENSOFT) for the ENSOFT product ("PRODIICT™)

identified on the current installation screen. The PRODUCT indudes

computer software and assocated media, printed materials, hardware key
(dongle), and electronic documentation. The PRODUCT also indudes any
updates and supplements to the original PRODUCT that may have been
produced by ENSOFT. By installing, copying, downloading, accessing or
otherwise using the PRODUCT, you agree to be bound by the terms of this
LICENSE. If vou do not agree to the terms of this LICEMSE, do notinstallor ™

(@) YES -1 Accept the terms of the License Agreement!
(71 NO - I DO NOT Accept the terms of the License Agreement!

wwiw, ensofting. com < Back ][ Hext = ] [ Cancel ]

Figure 2.2 Installation screen with License Agreement (may change with time)

Type of Key (Dongle)

23

Please select the type of dongle that was received from Ensoft:

@ Black Color (USB Key)
Use for either Single or Netwark Users

1 Green Color (USB Key)
Use only for Single Users.

I Beige Color (Parallel Key)
Use only for Single Users.

) DEMO VERSION (No Key)

www .ensofting, com [ < Back ][ Next = ] [ Cancel ]

Figure 2.3 Selection of Single-User License (may change with time)
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[~ ol

Choose Destination Location @

Choose Destination Location

setup will install StablPro v3.0in the following directory.
To install to this directory, didk Next.

To install to a different directory, dick Browse and select another directory.

Destination Directory

Browse...

C:\Program Files\Ensoft\StablPro3

Space required on drive: 10.6 MB
Space available on drive: 43220.7 MB
— QSetup
www.ensoftine. com < Back “ MNext = | [ Cancel ]

Figure 2.4 Default Installation Directory for Program Files (may change with time)

Set File Asscciation 23] I

Set File Association

Setup will associate some file types with StablPro v3.0.
Select the file types you want to assodate, dear the file types you do not want
to assodate.

File Types:
& .sid StablPro w3 Data File

— QSetup
www.ensoftinc. com ’ < Badck " Next = | ’ Cancel

Figure 2.5 File Extension Association for STABLPRO 2015 Data Files (may change with
time)

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 2 - Installation and Getting Started — 2-6

Set Program Shortcuts 22|

Set Program Shortcuts

Setup will add Shortcut to the Start/Program menu.

Start/Program Menu
Ensoft\StablPro20 14
Shortcuts are available for - All Users vl
s ensoftnccon <o [ mext> | [ conce |

Figure 2.6 Default Shortcut Folder in Windows Start Menu (may change with time)

2.1.2 Introduction of Network Version

Special network licenses and USB hardware keys (network keys) are available for users who desire
to operate STABLPRO on a Windows network. The network version is limited to users with two or more
licenses at the same physical site. Discounted rates apply for users purchasing multiple licenses for the
same site.

Network versions of STABLPRO have special subroutines written for installations in “software
servers” and for installations of “individual clients”. The “software server” or “license server” is the
computer that will be carrying the network USB key provided by ENSOFT, INC. The software server is
not necessarily the same as the existing network server. Any computer in the existing Windows network
may be designated software server for STABLPRO as long as the network key is attached to an available
USB port (or through an USB hub) and the “server” version of the software is installed on its local drive.
Software “clients” may be all computers of the licensed site that have the program installed as client.
Software clients do not need any hardware key attached to their computers. The program installed in
software clients will be allowed to run if their IP are within the allowable (licensed) IP ranges and if the
computer designated as software server is accessible on the network with the proper operating system and
with its network key secured in place.

Users of the network version of STABLPRO are allowed to have the software installed in as many
computers as desired within the licensed IP ranges of their local Windows network. However, only a
number of users equal to the total number of purchased licenses will be able to operate the program at the
same time.
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2.1.2.1 Installation of Network Version

Installers of network licenses should refer to a separate booklet with installation instructions for the
Network version of this product. The document can be downloaded from the Ensoft web site:

http://www.ensoftinc.com/updates/Ensoft Network Installation Notes.pdf

Alternatively, the document can be requested via email to support@ensoftinc.com

2.1.2.2 Silent Installations on Client Computers

For installation of network licenses on local client computers there is an option for command-based
installations that are completely silent (performed without other user input). Instructions for silent
installations on client computers can be downloaded from the Ensoft web site using the following link:

http://www.ensoftinc.com/updates/Silent Install on Client Computers.pdf

Alternatively, the document can be requested via email to support@ensoftinc.com

2.1.3 Backup of Original Software

The distributed software may be copied for backup purposes. The program may be installed in
several computers at the same time. However, unless network licenses are purchased, the program will
only operate in computers that carry the appropriate hardware key.

2.1.4 Software Updates on the Internet

Occasionally, ENSOFT will produce software improvements and/or fixes and place the latest
software programs on ENSOFT’s internet site. Users can check for available updates by selecting
Help/Check for Updates from the STABLPRO menu. Software users may freely download the latest
program update from the following site: http://www.ensoftinc.com

2.2 Getting Started

A general diagram showing the menu choices and operational flow chart of program STABLPRO
is presented in Figure 2.7. The following paragraphs provide a short description of the operational
features of STABLPRO and should quickly enable the user to get started with the program.
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Double chck the icon
STABILPRO
in the STABLPRO folder

~i

File Menu

Open an existing data file or begin
a new blank file

~i

Data Menu
Input required data of soil properties. slope
geometry and boundaries, and search
method. Start from the top submenu and

continue with each consecutive option
below

~

Computation Menu
Once finished with the data input, the Run
Analysis submenu performs the necessary
computations. This menu also contains options
for observing the plain-text input. output, and
L processing run files created by the program.

~i

Graphics Menu
Observe several types of
output graphics produced

by a successful run.

Help Menu

Avallable for most commeands.

iy

Figure 2.7 Sample organization and operational flow chart

2.2.1 Starting the Program

The program is started by double clicking the left mouse button anywhere in the STABLPRO icon.
A new window will appear on the screen, with the following top-menu choices: File, Data, Options,
Computation, Graphics, Window, and Help.
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2.2.2 File Management

The File menu option contains five submenus, as shown in Figure 2.8; they are:
New to create a new data file.

Open... to open an existing data file.

Save to save input data under the current file name.

Save As... to save input data under a different file name.

Exit to exit program STABLPRO.

Other entries include quick access to a history of recently-opened files.

% StablPre 4,010 - NewSlope = [ B )
Data Options Computation  View Window Help

Mew Ctrl+M

Open... Ctrl+0

Save Ctrl+5

Save As...

1 Examples\Exama-v3.sld
2 Bxamples\EXAM11-v3.sld

Exit

Figure 2.8 Options contained in the File menu

Several additional files are created in every new STABLPRO run. A general description of these
files is presented in Table 2.1. Every run of STABLPRO thus generates four text files in the same drive
and directory where the input-data file was saved or opened. Any of these files may be opened with
standard text editors or word processing programs.
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File

Name Usage File Example
Extension Description Format Files
*.sl4d Input-data file Text file | examplel.sl4d
example2.sl4d
*.sl4o Output-data file Textfile | examplel.sl4o
example2.sl4o
*.sldp Plot-data file Text file | examplel.sldp
example2.sldp
*.sldr Proce:islcér-data Textfile | examplel.sl4r
example2.sl4r

Table 2.1 Files created in STABLPRO runs

2.2.3 Data Menu

The Data menu contains several choices of submenus, as shown in Figure 2.9. The choices are
listed below, along with a general description of their use.

Title...cooveee. to enter a single line of text with a general description for the project.

Slope Boundary............. the total number of boundary lines and the boundary lines used to define the
surface boundaries may be entered. The entry will also define the coordinates of each
profile line for the geometry of the slope and the soil strata..

Soil Properties .. ............ appropriate properties of each soil layer, such as undrained shear strength, or
angle of internal friction, and other soil properties may be entered. The input for this
submenu is also to identify the soil types exhibiting anisotropic properties of shear
strength. This is an optional input that is disabled, as a default, for all new files.

Loading........... this submenu is used to input the data for two loading: surface loads and earthquake
loads. This is an optional input.

Water Surface ............. this submenu is used to input data for the piezometric surface. This is an
optional input.

Trial Surface Limit......... this submenu is used to input data for confining critical surfaces within certain
zones. This is an optional input.

Tieback ........... this submenu is used to input data for tieback or concentrated loads. This is an optional
input.

Reinforced Earth Layers .................. Program STABLPRO v3 allows the user to analyze embankments

constructed on soft ground reinforced with one or more layers of reinforcement. The user
enters the location of each reinforcement layer, the distribution of available force, and the
direction in which the force acts.

Failure Surface Search .................. the submenu under this menu are as follows: Specified Failure
Surface allows the user to specify the predefined or a given failure surface;. Circular

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 2 - Installation and Getting Started — 2-11

Search (Janbu Method) allows the use of Janbu’s procedures to search for the circular
failure surface; Circular Search (Bishop Method) allows the of use Bishop’s procedures
to search for the circular failure surface; Irregular Surface Search allows the use of
Janbu’s procedures to search for the irregular failure surface; Block Surface Search
allows the use of Janbu’s procedures to search for the block failure surface; and Circular
Search (Spencer Method) allows the of use Spencer’s procedures to search for the
circular failure surface.

[

% StablPro 4.0.10 - NewSlope = |[[E] )
File Options  Computation  View  Window Help
Title

Slope Boundary Lines
Soil Properties
Water Surface(s)

Surcharge and Earthquake Loading (optional) 3
Trial Surface Lirits (opticnal)

Tiebacks (optional)

Sets of Reinforced Earth Layers (optional)

Failure Surface Search Controls »

Figure 2.9 Options contained in the Data menu

2.2.4 Options Menu

The Options menu is provided for the control of program variables and preferences. The listing of
menu options is shown in Figure 2.10 and the different submenu choices are briefly described below. The
user may select any of the options without concern for the sequential order.

units ... the user may select either English Units (using Ibs and feet) or S.I. Units (using kN and
meters). English units are enabled, as a default, for all new runs. The user may change
the system of units as many times as desired and values that were previously input will be
automatically converted by the program to the new selection of units.

Control Options.............. the user may select the length of each computation increment and also how
often to print results. The observation of text files associated with STABLPRO (input,
output or processor notes) is done using the text editor that is here selected by the user.
The user should input in this box the complete path and command line for the preferred
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text editor or word processor that will be used to examine and print the input, output and
processor plain text files created by the program. As a default, the command line
c:\windows\notepad.exe is used to operate the standard text editor Microsoft Notepad that
is normally included with all Windows installations.

% StablPro 4.0.10 - NewSlope | )
File Data Computation  View Window Help

Units r

Text Editor

Figure 2.10 Options contained in the Program-Control Options menu

2.2.5 Computation Menu

The Computation menu is provided to run the analytical computations after all data are entered
and saved. After the computation is executed successfully this menu also provides options for the
reviews of plain-text input data, notes produced during computation, and output data. It also provides an
option for the graphical observation of the modeled pile and soil layers. Submenu choices, shown in
Figure 2.11, are briefly described below.

Run Analysis .. ............... this option is chosen to run the analytical computations. This option should be
selected after all data have been entered and saved.

Edit Input Text ............... this option calls the chosen Text Editor (selected under Options/Text Editor)
to observe and/or edit the analytical input data in plain-text format. The option becomes
available after the input data has been saved to disk, or when opening an existing input-
data file.

Edit Processor-Run Notes ............... this option calls the chosen Text Editor (selected under
Options/Text Editor) to observe, format, and/or print the notes provided during
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processing. The option becomes available (or modified) after a run attempt has been
made. The user is encouraged to read the processor-run notes if the program is not
running successfully. The processor-run notes may provide the user with some additional
information about possible causes of the problem.

Edit Output Text............. this option calls the chosen Text Editor (selected under Options/Text Editor)
to observe, format, and/or print the analytical-output data. The option becomes available
only after a successful run has been made. Certain output files may be too large for the
Microsoft Notepad editor, so other text editors would have to be used (Microsoft Word
Pad should be able to open most text files).

Error Message Notes... this submenu option is used to view an intermediate text file that provides the detailed list
of error messages. If a program is not executed successfully due to some input errors, the specific
error number will be generated in the output file. The user may open the output file to locate the
error numbers; then find out the exact reasons for the error by looking into the error message note.
This submenu automatically invokes the word processor or text editor specified by the user. The
default setting is to use the utility program named notepad.exe provided by Microsoft Windows®.

% StablPre 4.0.10 - NewSlope = |[[E] )
File Data Gpticlns‘l.n’ian.r Window Help

Run Analysis

L o

Edit Input Text
Edit Qutput Text

Error-Message Motes

Figure 2.11 Options contained in the Computation menu

2.2.6 Graphics Menu

The Graphics menu is used to observe plots of output data provided by a successful program run.
Options for the observation of output results under this menu are only enabled after a successful run has
been made. Even after performing successful runs, some options may still be disabled since the amount
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of output data depends on specifications provided in the input file of each program run. Submenu
choices, shown in Figure 2.12, are briefly described below.

Most of the graphical representation of input data may be shown on the screen for verification by
checking one or more of the following option boxes.

Profile Line..... .............. show user-specified soil profile including the slope geometry.
Profile Numbers ........... show the profile number for easy identification of soil layers.

Profile Coordinates....... Show coordinates of each point on the soil profile that were entered by the

user.

Color Soil Layers..........show color on each soil layer for distinction.

Tiebacks... ...... ccccovviienns Show locations of user-entered tiebacks.

Piezometric Lines......... Show the pierometric surfaces defined by the user.

Surface Pressure........... .show surcharge loads or other surface pressure that were entered by the user.
Reinforce Lines............. Show the layout of the reinforce lines defined by the user..

The computed results can be shown on the screen for graphical representation. There are nine
options for graphics as listed below.

Solution Information...... show the factor of safety and center of rotation of the most critical failure
surface.

10 Slip Surface... ......... show the 10 most-critical slip surfaces searched by the program.
Critical Slip Surface...... show the most critical slip surface found by the program.

All Trial Surface.... ........ show all the trial slip failure surfaces generated by the program.
Total Stresses............... show the distribution of the total stresses on the slip failure surface.

Pore Water Pressure.... Show the distribution of pore water pressure on the slip failure surface.
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L"&Ensnft Graphics Utility for STABLPro, x=15.56, y = 5.23 = |0 ﬂ

Input Data:

I
Tie Backs
Fizzomeatic Line
Surface Pressures
Feinf. Lines
Computed Values:
Solution Information
10 Slip Surfaces
Critical Ship Surface
All Trial Surfaces
Total Sraszes
Fore Water Pressures

Move Yiew

Left | Right
Do

Figure 2.12 Options contained in the Graphics menu

2.2.7 Arrangement of Windows

The Window menu provides two standard functions for organizing opened windows and/or
minimized window icons. Submenu options, shown in Figure 2.13, are briefly described below.

Cascade.......... this option organizes all open-windowed menus so that all become visible with their tops
cascading from the top left portion of the screen.

Arrange Icons. ............... this option organizes the icons of all minimized windowed menus so that all
become visible and aligned at the bottom portion of the screen.

Other entries under the Window menu are names of any open windows or plot file, that the user
may select to navigate between open windows.
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M StablPro 4.0.10 - EXAMI1-v3 = | = E=
File Data Options Computation View Window Help
ﬂ Slope Boundary

My ﬁ_SuiI Properties
| Wi Water Surface == &=

Co

a0 Line of seepage

Groundwater table

2

[ Specify piezametric surfaces

Unit weight of water (kiN/m™3) |0

Figure 2.13 Sample options contained in the Window menu

2.2.8 Help Files

The Help menu provides an online help reference on topics such as: using the program, entering
data, information about variables used in the program and methods of analyses. Submenu options, shown
in Figure 2.14, are briefly described below. The menu may be accessed at any time while in STABLPRO.

Contents ......... the main reference files for help are accessed through this submenu option. The Help
files usually do not provide as much information as the electronic manuals that are also

accessible from the Help menu.

User's Manual ............... this selection calls the installed version of Adobe Acrobat or Acrobat Reader to
open the User’s Manual. This document is formatted as an Adobe PDF file.
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Technical Manual .......... this selection calls the viewer of the Technical Manual. This is a protected file
(copyright document) that can only be opened with this viewer and by user’s that are
running the program in full mode.

About............... this provides a screen describing the program version, date, maintenance expiration date,
USB serial number and methods for accessing technical support.

Check for Updates ........ starts the default Internet browser and sends the user to a page that describes
information about the user’s license (release and maintenance expiration date) as well as
the latest release that is available for downloading at the Ensoft site. Users may only run
in full mode maintenance updates that were released before the expiration date of the
user’s license.

% StablPro 4.0.10 - EXAM11-v3 = | B[]
File Data Opticns Cemputation VYiew Window | Help
Contents
About...
ﬂ Slope Boundary
MHumber of boundary lines uzed to defing the surface IE
Coordinates of each boundary line Erter Boundary Coordinate Data

Coordinate points are defined by a, b, c, d, e, f and g.
Lines 1, 2, 3, 4, and 5 are boundary lines.

Lines 1, 2, and 3 define the surface boundary.

Every boundary line must be defined before all
underlying lines.

C 3 d
.2/l [
Soil 1
b
am ! 4 me
Soil 2

Figure 2.14 Options contained in the Help menu

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 2 - Installation and Getting Started — 2-18

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 3. References for Data Input

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 3 —References for Data Input — 3-2

3.1 Introduction

The DATA Menu consists of different input items for data entry. A total of 8 input items are
provided under the DATA Menu. The user may select any one of them without concern for the sequential
order. Some of the input parameters are optional and the user can skip those parameters if they are not
applicable to the encountered problem. However, Items 1, 2, 3, and 7 are always required. Input-data
files created for STABLPRO are provided with a standard file-name extension in the form of *.sl4d
(where * represents any allowable file name). All input-data files are standard text files and may be
edited with any text editor or word-processing program for the input file. The user may use the mouse to
click any of these items for viewing. Consistent units should be used throughout the data input.

STABL is compatible with any system of units which the user may prefer for analysis. If
consistent units of length and mass are used, the program will function without error. For example, one
may use the following:

Coordinates: feet (ft) or Meters (m)

Unit Weights: pounds/cubic foot (pcf) or kilograms/cubic meter (kN/m3)
Strength Intercept: pounds/square foot (psf) or kilograms/square meter (kN/m2)
Pore Pressure: pounds/square foot (psf) or kilograms/square meter (kN/m2)

Unit Weight of Water: 62.4 pcf or 9.8 kN/m3

The default units in the program are “ft” and “lbs”. Each slope to be analyzed is made left-facing
and placed in a first quadrant position so that all coordinates will have positive values. It is necessary to
plot the problem's geometry to scale on a rectangular coordinate grid. Coordinate axes should be chosen
carefully such that the total problem is defined within the first quadrant. This enables the graphic aspects
of the program to function properly. For best resolution and interpretation of output data, the extent of
coordinate limits should define the problem geometry, and permit analysis of the most critical failure
surfaces. Potential failure surfaces developing beyond the toe or the crest of the slope must be
accommodated (Figure 3.1). Deep trial failure surfaces passing below the horizontal axis are not allowed,
nor are trial failure surfaces which extend beyond the defined ground surface in either direction . If any
coordinate point defining the problem's geometry is detected by the program to lie outside the first
guadrant, an appropriate error code is displayed and execution of STABLPRO is subsequently terminated.
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Well beyond crest

Well beyond toe
—————— Deep

Figure 3.1 Example slope geometry and subsurface profile

3.1.1 File = New

Once the program is started, default values are used for certain operating parameters and a blank
input-data file is created. Selecting New under the File menu resets all STABLPRO variables to either
default or blank values, as appropriate. This option should be selected when a new data file is desired to
be created from a blank form. This menu option may also be accessed with the Ctrl+N keyboard
combination.

3.2 File Menu

This menu contains options related to the management of input-data files and to exit the program.
Input-data files created for STABLPRO are provided with a standard file-name extension in the form of
*filename*.sl46d (where *filename* represents any allowable file name). All input data files are standard
text files and may be edited with any text editor or word-processing program.

3.2.1 File = New

Once the program is started, default values are used for certain operating parameters and a blank
input-data file is created. Selecting New under the File menu resets all STABLPRO variables to either
default or blank values, as appropriate. This option should be selected when a new data file is desired to
be created from a blank form. This menu option may also be accessed with the Ctrl+N keyboard
combination.
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3.2.2 File-0Open

This is used to open a file that has been previously prepared and saved to disk. The File — Open
window dialog, shown in Figure 3.2, is used to search and open an existing input-data file. By default,
the file is initially searched in the directory where STABLPRO was installed. Standard windows-
navigation procedures may be used to locate the name and directory of the desired project file. This menu
option may be accessed with the Ctrl+O keyboard combination.

Every analytical run of STABLPRO produces several additional files (previously described in
Table 2.1 of this manual). The name of the input-data file indicates the names of all related files
produced by a successful program run (output, graphics, and processor text files). All the additional
program files will be created in the same directory as the input data file. Input-data files that are partially
completed may be saved and later opened for completion, run, and observation of results.

Opening some partially-completed STABLPRO input files or invalid data files (or files with
incorrect data formats) may produce an information window reporting that an “invalid or incomplete” file
is being opened (Figure 3.3). The user should click the OK button and all partial-input data that was
previously prepared should become available.

The program allows users to read input-data files created for the previous STABLPRO 3.0 version
(*.sld file extension) by selecting the drop-down arrow under the Files of type: option at the bottom of
the File — Open window screen. The program will automatically convert the opened STABLPRO v3.0
input files to STABLPRO (the latest version) when the user saves the opened file.
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5

W: StablPro 4.0.10 - EXAM11-v3 (o |[= ] =]
File Data Options Computation WView Window Help
% Open ==
Loak in: I || bamples j = IfF "'
Marne - Date modified Type y
Mo iterns match your search,
1 | II] F
File name: | Open
Files of type: | StablePro 2014 (" sl4d) | Cancel |
StablePro 2014 (" sl4d |
StablePro 3.0 (*.sld)
Al Files (.7)
Figure 3.2 Window screen for the File — Open dialog
( R
Information ﬂ
Error on Line 8 Item 1
An integer was expected but not found.
" o
Figure 3.3 Sample message for incomplete or invalid file
User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 3 —References for Data Input — 3-6

3.2.3 File - Save

This option is used to save input data under the current file name. With this method of storing data
to disk, any input data that was previously saved with the same file name is replaced with the current
parameters. Input-data files should be saved every time before proceeding with runs for analytical
computation. This menu option may also be accessed with the Ctrl+S keyboard combination.

3.2.4 File-Save As

This option allows the user to save any opened or new input data file under a different file name or
different directory. Any input data file saved under an existing file name will replace the contents of the
existing file.

3.2.5 File - Exit

This is selected to exit STABLPRO. Any input-data file that was modified and not yet saved to
disk will produce a confirmation window before exiting the program (see Figure 3.4).

Confirm &J‘

'e' Do you want to save any changes?

.................................

Yes ! No Cancel

" .

Figure 3.4 Message window advising that changes were not saved to disk

3.3 Data Menu

The input of specific parameters for an application is controlled under options contained within this
menu (shown in Figure 3.5). It is recommended that the user choose each submenu and enter parameters
in a consecutive manner starting from the top.

Selecting or clicking any of the submenu choices contained in the Data menu produces various
types of windows. As a reminder of standard commands of Microsoft Windows®, open windows may be
closed by all or some of the following methods:

clicking the OK button (if available),or

e clicking the X-box on the upper-right corner of the window, or

e  pressing the “Ctrl+F4” keyboard combination, or

e double-clicking the STABLPRO icon on the upper-left corner of the window, or

e clicking once on the STABLPRO icon on the upper-left corner of the window and then
choosing Close.

Open windows may optionally be left open on the screen. The selection of other menu options will
then produce new windows on top of those that were previously left open.
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Many sub-windows of the Data menu will show an Add Row, Insert Row and/or Delete Row
buttons. The Add Row button always adds new rows at the end after all existing rows. The Insert Row
button always inserts a new row right after an existing row highlighted by the mouse. Clicking on the
Delete Row button deletes the row where the cursor is located.

[

% StablPro 4.0.10 - NewSlope | )
File Options  Computation  View Window Help
Title

Slope Boundary Lines
Soil Properties
Water Surface(s)

Surcharge and Earthquake Loading (optional) r
Trial Surface Limits (opticnal)

Tiebacks (optional)

Sets of Reinforced Earth Layers (optional)

Failure Surface Search Controls »

Figure 3.5 Options contained in the Data menu

3.3.1 Numeric Data Entries

Cells that require numeric data may accept entries of mathematical expressions in addition to
simple numeric entries. Entering a mathematical expression works similarly to normal numeric data. The
user types the expression that represents the data and presses the Return key to calculate the entered
expression and to display the numeric result in the same cell.

Table 3.1 below shows the list of supported operations and constants. The order of operations
follows the order in the list of Table 3.1. Note that implicit multiplication (i.e. 2(4+6)) is not supported
(instead, use 2*(4+6) for the previous example).

OPERATORS
Symbol Description
0 Parenthesis (may be nested)
VAN

Exponentiation

* Multiplication
/ Division
+ Addition
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- Subtraction
- Negation (same as subtraction)

CONSTANTS
Symbol Value
PI (or pi) 3.1415927
e (or E) 2.7182818

Table 3.1 Supported mathematical operations and constants

The two constants that are currently supported are Pl and e. Implicit multiplications using
constants is not supported (use 2*e instead of 2e). Negation of the constants Pl or e is not allowed. For
instance, instead of entering -PI the user must enter - (PI).

Scientific notation (i.e. 1.65e8 or 1.65e-8) may be used to input very large or very small numbers.
After an expression is calculated, very large or very small numbers will be displayed using scientific
notation.

3.3.2 Data - Title

This option activates the window shown in Figure 3.6, where the user can enter a line of text
containing a general description for the application problem. Any combination of characters may be
entered in the text box in order to describe a particular application. The user input will be restrained
automatically once the maximum length of text is reached. This is done to prevent the user from going
beyond the maximum permissible length of characters allowed for the title line.

R StablPro 4.0.10 - EXAMI1-v3 = || = T |

File Data Options Computation VYiew Window Help

W) Project Title = || = | &2 |

Enter text line for project description:

Mew Slope

Figure 3.6 Window screen for sample Data - Title
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3.3.3 Data —Slope Boundary

The input for slope boundaries will appear on the screen if Item - Slope Boundary of the
Data Menu is selected (Fig. 3.7). Two entry fields are required. The two fields are related to (1)
the total number of boundary lines and (2) the boundary lines used to define the surface
boundaries. The graphical sketch on the screen will help the user to visualize the definition of

the variables.

It should be noted that the slope to be analyzed is made left-facing as shown in the screen and
placed in a first quadrant position so that all coordinates will have positive values. The ground surface
boundaries are numbered first, from left to right consecutively, starting with “1”. All subsurface
boundaries are then numbered in any manner as long as no boundary lies below another having a higher

number.

After the number of total boundary lines is entered, the screen will present a grid table to
define the coordinates of each profile line. This table is used to label input data of the slope
geometry and any subsurface boundaries forming the soil strata. Up to 25 different boundaries
can be specified. Five entries are required for each profile line, two for the x and y coordinates at
the left end, two for the x and y coordinates at the right end, and one for the soil type beneath the
profile line. The x and y coordinates are defined by real numbers, but the soil type should be an

integer.

". Slope Boundary

Mumber of boundary lines used to define the surface B

Coordinates of each boundary line

| Enter Boundary Coordinate D ata |

Coordinate points are defined by a, b, c. d, e, f and g.
Lines 1, 2. 3, 4, and 5 are boundary lines.

Lines 1, 2, and 3 define the surface boundary.

Every boundary line must be defined before all
underlying lines.

,L‘ Coordinates of Boundary Lines = || B || £2

/97
\i\ﬁ

C 3 d
2 N
] b Soil 1
a e
Soil 2
f < [i}
Soil 3

Left [f) |LeftY[ft] |F|ight><[ft] |F|ightY[ft] |SoiINumber -

I EE Ba.4 £7.7 £7.1 1
2 g7z £7.1 72 £9.2 1
3 |2 £9.2 &0 707 1
4 Jan 0.7 85 753 1
5 |5 753 505 78z

SEN 78.2 110 782 1
7 |s4m B4.9 905 £2.9 )
FEEN £2.9 110 £2.9 2
3 |543 B3.1 905 B0 3
10 |a05 B0 101 B4 3
lw‘ Inzert Row Delete Row

Up to 100 boundary lines can be defined.

E ach boundary line iz defined from left to right.

Boundary linez thould be ordered 2o that each boundary

line iz defined before all underying boundary lines.

The zoil number iz the soil type immediately underying the boundary
line. The slope should slide fram the right side ta the left side.

Figure 3.7 Window screen for sample Data —
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Data for soils exhibiting anisotropic properties may be entered on this screen. To open the
input screen for strength anisotropy, the user can click the “button” if the soil has anisotropic
properties.

3.3.4 Data - Soil Properties

The Soil Property item from the Data menu may be clicked and the input screen for soil properties
will be shown on the screen (Fig. 3.8). A total of 20 different types of soil can be specified on the screen.
The soil parameters for each type of soil are moist unit weight, saturated unit weight, strength intercept
for isotropic soil, strength angle for isotropic soil, pore-pressure parameter, pore-pressure constant, and
the index number for the piezometric surface. The units should be consistent throughout the input of data.

If the strength properties are judged to be significantly anisotropic, the soil types exhibiting
anisotropic strength properties should be specified on the screen. Once the anisotropic option for each
soil type is clicked, another table will be shown on the screen for entering soils anisotropic properties as
shown in Fig. 3.8. A general description for the input needed under each item of the Data — Soil
Properties submenu option is listed below.

Soil Type Number

This is the number assigned to each soil type, which corresponds to the entry in earlier section for profile
lines. The maximum number of rows for soil layers should be equal to the maximum soil type number
been selected in profile entries.

Moist Unit Weight

This is the moisture unit weight (in-situ unit weight) for the soil. In the case of a soil layer is above the
water surface, the program will use the moist unit weight for computation. The English unit for this

variable is “pcf”, while “kN/M3” is for the ST unit.
Saturated Unit Weight

This is the fully saturated unit weight for the soil. In the case of a soil layer is below the water surface,
the program will use the saturated unit weight for computation. The English unit for this variable is

“pcf”, while “kN/M3” is for the ST unit.
Isotropic Strength Intercept

This is the cohesive strength ¢ for an isotropic cohesive soil. Either an effective stress analysis (¢, ¢’) or
total stress analysis (c, $=0) may be performed by selecting the appropriate value for the Mohr-Coulomb

strength parameters. The English unit for this variable is “psf”, while kN/M2” is for the SI unit.
Isotropic Strength Angle

This is the internal friction angle for an isotropic cohesionless soil. Either an effective stress analysis (¢’,
¢’) or total stress analysis (¢, $=0) may be performed by selecting the appropriate value for the Mohr-
Coulomb strength parameters. The unit for this variable is “degree”.

Pore Pressure Parameter

Excess pore water pressure due to shear can be assumed to be related to the overburden by this single
pore-pressure parameter (r,,). The overburden does not include surcharge boundary loads.

Pore Pressure Constant
The pore pressure constant (ug) of a soil type defines a constant pore pressure for any point within the soil

described. The English unit for this variable is “psf”, while “ kN/ m2” is for the SI unit.
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& StablPro 4.0.10 - Bam7-v3 [ =]=]
File Data Options Computation View Window Help
A Soil Properties (o= =]
Layer | Maist Unit S aturated Unit |zotrapic Cohesion  |lzotropic Strength Pare Pressure | Pore Pressure Piezometric: Apizotropic Parameters
Weight lbs/ft"3] [Wweight (lbs/ft"3] |Intercept (bs/ft™2] |Friction Angle [DEG.) | Coefficient Constant [lbs/ft"2) |Surface Mumber | [optional]
1 136 138 473 0 0 0 1 1: Anizotropic Strength D ata
2— 173 173 233 0 0 0 1 2. Anizotropic Strength D ata
3— 17.3 173 363 0 0 0 1 3 Anizotropic Strength D ata
4_ 136 138 0 3B 0 0 1 4. Anizotropic Strength D ata
Add Row Inzert Row | IW‘
50 soil types maximurm
& Anisotropic Strength Data 2 (=)= =]
Layer | Counterclockwize Strength Strength
Direction Limit [DEG.] |Intercept [lbs/ft™2] |Friction Angle (DEG.)
1 50 18 1]
ERES 22 0
3 a0 24 0
FEED 18 0
Add Row Inzert Row Delete Row

20 roves masirum

Figure 3.8 Window screen for sample Data — Slope Boundary

Anisotropic Soil

The soil types exhibiting anisotropic strength properties should be specified on the screen. Once
the anisotropic option for each soil type is clicked, another table will be shown on the screen for entering
soils anisotropic properties as shown below. Each direction range of an anisotropic soil type is
established by specifying the maximum (counterclockwise) inclination angle (in degrees) of each discrete
range. The data set consists of the inclination angle (o) and the Mohr-Coulomb strength angle( ¢) and
strength intercept (c) for each discrete range. Data for each discrete range are required to be prepared
progressing in counterclockwise order, starting with a first range from —90 degrees to oq (specifying oq

as the next counterclockwise direction angle), then to the last range of +90 degrees.. The process is
repeated for each soil type with anisotropic strength behavior.

3.3.5 Water Surface

This submenu is automatically enabled if the user selected to analyze a pile type with a noncircular
cross section (under Data — Pile Material). This submenu option allows the user to input dimensions and
section properties for piles with noncircular cross sections. A general description for the data needed
under each entry of the Data - Noncircular-Section Pile submenu option is listed below and shown in
Error! Reference source not found.
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The WATER option is used to define up to 5 different piezometric levels with slope geometry. The data
can be successfully used to assign perched water tables and also to simulate pore-pressure distributions
within the soil strata.

To open the input screen for the piezometric surface, the user selects item Water Surface from the
Data menu, as shown on Fig. 3.9. A total of five piezometric surfaces can be specified on the input
screen. For each piezometric surface, the user may use up to 10 points to define the x and y coordinates.
When the entry of data appears to be correct, the screen is closed and return will be to the main Data
menu.

r

A StablPro 4.0.10 - Bxam7-v3

(==&
File Data Options Computation View Window Help
R Water Surface =R =R E
Line of seepage
N Groundwater table
v Specity piezometric surfaces
Unitweight of water (lbs/ft™3)  |62.4
Edit Biezometric Surfaces
A Piezometric Surfaces 1 [= =&
R Set of Piezometric Surfac... [= || = |[E2 | Fe (A |Y[fl]
Surface # 1 55 B 1
1 1: Piezometric Surfaces | 2 B3 671
3 10 70
Add Fow | Inzert Fow | |
Add Row Ingert B ow | Delete Row |
10 piezometnic lines maximurm
Figure 3.9 Window screen for sample Data — Water Surface
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3.3.6 Data - Surcharge and Earthquake Loading

External boundary loads which may be applied to the slope are defined by the menu command,
Surcharge and Earthquake Loading. Input of up to 10 loads is allowed, as a surcharge intensity in any
direction. A boundary load of varying intensity may be approximated by a set of equivalent uniformly
distributed loads abutting each other. For a pseudo-static earthquake analysis, the sub-menu EQUAKE is
used to assign vertical and horizontal coefficients to simulate the design earthquake.

To open the input screen for boundary surcharge loads and earthquake loads, the user selects Item -
Surcharge and Earthquake Loading from the Data menu. There are two categories for loading: surface
surcharge loads and earthquake loads as shown in Fig. 3.10. The user may select one or both loading
conditions.

% StablPro 40,10 - Exam7-v3 ==
File Options  Computation  View Window Help
Title

Slope Boundary Lines
Soil Properties
Water Surface(s)

Surcharge and Earthquake Loading (optional) » Surcharge Loading
Tral Surface Limits (optional) Earthquake Loading

Tiebacks (optional)
Sets of Reinforced Earth Layers (optional)

Failure Surface Search Controls »

Figure 3.10 Window screen for sample Data — Surcharge and earthquake Loading

The boundary surcharge loads may be specified on the input screen, as shown in Fig. 3.11. The
user should enter the x coordinates of two end points for each boundary load. The intensity and load
inclination are also required for the boundary load.
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,il StablPro 4.0.10 - Bxam7-v3 = =] &

File Data Options Computation View Window Help

& Surcharge Loads = = |[zx ]

[v Apply Surcharge Loads Inclination of the loaded area
is positive counterclockwize
fram the vertical

Edit Surcharge Loads

[ ﬂ Surcharge Loads [= = =]
Left = Coord. |Right = Coord, [Intenzity | COW inclination
[p<Li] [ft] [=Rif) (bs/ft"2] | [DEG.)
1 50 56 100 1]
2 56 EE 200 10
Add Fow | Inzert Fow | Delete Row |

Figure 3.11 Window screen for sample Data — Surcharge and earthquake Loading

If earthquake loading is applicable, values for all three fields designated for the earthquake
condition must be entered (Fig. 3.12). The data needed for earthquake loads are the coefficient for
horizontal acceleration, the coefficient for vertical acceleration, and cavitation pressure (optional).

W Earthquake Loading Coefficients = | = &

Earthquake coefficient for honzontal acceleration |D.3
[defined pozitive outwards from the face of zlope]

Earthquake coefficient for vertical acceleration |D.3
[defined pozitive upwards]

Cavitation pressure (lbs/ft™2) |EI

Figure 3.12 Window screen for sample Data — Surcharge and earthquake Loading

3.3.7 Data - Trial Surface Limit

Program STABL can automatically search for the failure surface based on the boundaries that are
specified. If the user wishes to confine critical surfaces within certain zones, the option for Trial Surface
Limit may be used. The generation of critical planes is beyond the defined limiting boundary, such as
competent rock underlying the slope. Alternatively, one could simply introduce the rock as a soil type
with a high strength, which would effectively lead to higher factors of safety (FOS) for a surface passing
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through the rock. However, the LIMITS option is more efficient because computer time is not wasted in
computing a high FOS.

Additionally, an upper limiting boundary can be implemented which is useful for stability
analysis of retaining structures such as sheet-pile walls, anchored bulkheads, reinforced earth walls, and
related structures.

The input shown in Fig. 3.13 will appear on the screen by selecting Trial Surface Limit from the
main Data. A total of 10 generated boundaries can be specified on the screen. The x and y coordinates at
the right and left ends are required for each boundary line.

o

& Trial Surface Limits (optional) =N el

v Specify tral surface limits

Edit Trial Surface Limits O ata Surface Limit Lines

[ R Specify Trial Surface Limits =EE

Point | Left point Left paint Right point | Right point
¥ Coord. [ft] |* Coord. [ft] |* Coord. [ft] [% Coord. [f)

1 a 15 29 24

2 24 24 51 26

3 a1 25 78 Gk

4 78 BB 94 E5

b 94 Eh 113 E4

E 113 &4 133 5E

7 133 5E 161 58

2 161 5 205 7E

9 g3 73 93 E7

LU =K &7 138 103

Add Fow Inzert Row | ’Wl
50 firnit lines masimum

Figure 3.13 Window screen for sample Data — Trial Surface Limit

3.3.8 Data - Tieback

Program STABLPRO allows the user to specify tieback loads on the slope. Procedures to compute
the factor of safety will include the effects of tiebacks. Tieback or concentrated loads applied to the slope
are defined by the menu command, TIEBACKS. This option allows input of up to 10 horizontal or
inclined concentrated loads to be applied to the profile surface. The TIEBACKS option is fully described
in the technical manual.
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The user may select Item Tiebacks from the main Data menu, and a drawing with slope geometry,
tieback location, and the failure surface will appear on the screen, as shown in Fig. 3.14. The
geometrical data required by the program can be easily interpreted by the user with the graphical
presentation. Up to ten tiebacks can be specified on the cross section of a slope. The distance between
two cross sections with tiebacks is required because the force on each plane section will be averaged,
based on the tieback distance. The second column in the table is the boundary number where tieback load
is applied. The third column in the table is the X coordinate of the point of application of tieback load (ft)
or (m). The fourth column in the table is the Y coordinate of the point of application of tieback load (ft)
or (m). This column can be left as zero if the user would like to let the computer generate internally. The
fifth column in the table is load per tieback (Ibs) or (kN). The spacing on column No. 5 is for the
horizontal spacing between tiebacks (ft) or (m). The inclination of tieback load in column No. 6 is
measured clockwise from the horizontal plane (deg). The last column of the table is for free length of
tieback (ft) or (m) [equal to zero if other than tieback load].

L‘ User-Specified Tieback Data

o || B EE

M Tiebacks ==
V¥ Speacify tiebacks ’-b A
Edit Tiehack Data G P Crest
SETTIINNG T Fia Ny d
H
ll-_ 1
S—Tiebacks—"
0] g loe
TIPS 7 TIIFoN TIONT
Section A-A
A Elevation
@ Ground surface boundary number where tieback load is applied.
(X.Y) Coordinates of point of application.
P Magnitude of load per tieback.
H Horizontal spacing between tiebacks.
I Inclination of tieback load (deg.)
L Free length of tieback.

Faint

Boundary

# Coord.

' Coord.

Load [Ibg]

Spacing

Inclination

Free Length [ft)

Surface #

(it}

[ft)

W]

[DEG.)

7

2

2
3

0
0

[
70

357
296.4

28
28

0
0

60
60

Add Fow Inzert Row | Delete Row |

15 tigbacks masirmum

Figure 3.14 Window screen for sample Data — Tiebacks

3.3.9 Data - Reinforce Earth Layer

Program STABLPRO allows the user to analyze embankments constructed on soft ground
reinforced with one or more layers of reinforcement. The simplified Bishop method for circular slip
surface was modified to include the stabilizing moment provided by the reinforcement strips. The user
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enters the location of each reinforcement layer, the distribution of available force, and the direction in
which the force acts.

The user may select Item Reinforcement Earth Layers from the main Data menu, and a drawing
with slope geometry, reinforcement location, and the failure surface will appear on the screen, as shown
in Fig. 3.15. The data required by the program can be easily interpreted by the user from the graphical
illustration. Up to 20 reinforcing layers can be specified. The location of each layer is specified by a
series of x,y coordinates starting at the left end of the reinforcement and moving to the right. In a typical
application the left end of the layer would be at the embankment toe or the face of the slope and would
extend across the full width of the embankment. The coordinates of each reinforcement layer must be
specified by at least 2 but not more than 40 points. The layer may be horizontal or inclined, however, the
user must employ judgment on the applicability of the analysis method if the layers are more than
moderately inclined. The inclination factor must be between 0.0 and 1.0. A factor of 0.0 specifies that
the reinforcing force acts in the direction of the reinforcement. A factor of 1.0 specifies that the force acts
tangent to the failure surface. The reinforce force must be inputted as positive value.

,L‘ Reinforce Earth Layers o || B[ E8 L Reinforce Earth Layer == =
v Specify ieinforce earth layers & Legen| [refltaven Bl e i
20 1 1: Reinforce earth Layer data
Edit Reinforce E arth Data = 2 2. Reinforce earth Layer data
b 3 3 Reinforce earth Layer data
5 4 4 Reinforce earth Layer data
< 101 —
v 5 5 Reinforce earth Layer data
> REINFORCEMEMNT LAYER
& E: Reinforce earth Layer data
¥ SOIL TYPE 2 7 7. Reinforce earth Layer data
L] 1 1 1 1 o~ 8 & Reinforce earth Layer data
o o 20 30 40 9 3. Reinforce earth Layer data
1 10: Reinforce earth Layer data =
X-AXIS (FT}
Ldd Row Inzert Raow | Delete Row |
DISTRIBUTION OF REINFORCEMENT FORCE
— L Reinforce earth Layerdat.. [ = || = || &2
[ 00 —
w Layer # | Coord. | Coard. |Force Inclination
m
= [m] [rm) [kM] Factor
L= 1 16 16 0 0
] l 1 1 I » 2 20 18 7290
a
10 2 34 40 3 45 16 7295 0
X-AXIS {FT} Add Row Inzert Row | Dielete Row |
30 reinforcement layers maximum

Figure 3.15 Window screen for sample Data — Reinforce Earth Layers

3.3.10 Data — Failure Surface Search

Six different methods of analyzing the stability of a slope are available for use in STABLPRO. To
specify the failure surface or the automatic-failure search, the user must first select Item Failure Surface
Search from the Data menu, as shown in Fig. 3.16. The option of specified failure surface is used for
determining the factor of safety (FOS) for a specific critical failure surface defined by coordinates input
by the user. However, if the user is at an initial- investigation phase, the options for JANBU, BISHOP,
and SPENCER (circular surfaces) and irregular surface search may be specified to utilize the program’s
unique capability to generate critical failure surfaces in a random manner. The user needs only to define
the initiation and termination limits of the failure surfaces.
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#w StablPro 4.0.10 - NewSlope =nE=R
File Options  Computation  View Window Help
Title

Slope Boundary Lines
Soil Properties
Water Surface(s)

Surcharge and Earthquake Loading (optional) 2
Trial Surface Limits (cptional)

Tiebacks (optional)

Sets of Reinforced Earth Layers (optional)

Failure Surface Search Controls 3 User-Defined Failure Surface
Circular Failure Surface Searched by Janbu's Method
Circular Failure Surface Searched by Bishop's Method
Irregular failure Surface Search
Block Search Method (random method)
Spencer's Method

Figure 3.16 Window screen for sample Data — Failure Surface Search

If block-type analysis is also required, the BLOCK option allows the user to generate random
blocks for analysis. For these blocks, the user can manipulate the size of the block zones to arrive at the
minimum FOS. Thus, by specifying the geometry and soils for the specific slope, the user can perform
numerous operations, using three different type of critical failure surfaces, to arrive at the most probable
value for the FOS of the slope.

In summary, Program STABLPRO features unique random techniques for generation of potential
failure surfaces for subsequent determination of the more critical surfaces and their corresponding factors
of safety. One technique generates circular failure surfaces, and another technique generates more
general irregular surfaces of random shape. The user may also specify a predetermined failure surface for
the computation of the factor of safety.

Since significantly more computation time is required for analysis of potential failure surfaces
using Spencer’s method of slices than either the Simplified Janbu or Simplified Bishop methods, the most
efficient use of the STABLPRO capabilities will be realized if the user first investigates a number of
potential failure surfaces using one of STABL’s random surface generation techniques which determines
the factor of safety using either the Simplified Janbu or Simplified Bishop method of slices. Once critical
potential failure surfaces have been identified, they may be analyzed using the SPENCR option to obtain
a factor of safety (FOS) satisfying both force and moment i.e., complete equilibrium.

When a user-input potential failure surface is analyzed, the program outputs the value of the
factor of safety with respect to force equilibrium (Ff), the value of the factor of safety with respect to
moment equilibrium (Fm), and the angle of the interslice forces (theta) calculated during iteration, along
with the value of FOS and theta satisfying complete equilibrium. When a user-input potential failure
surface is analyzed, the coordinates of the line of thrust, the ratio of the height of the line of thrust above
the sliding surface to the slice height for each slice, and the values of the interslice forces are all output.
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The only input restrictions require that specification of the “SPENCR”option occur prior to
specification of the method of surface generation and solution, i.e., SURFAC, CIRCLZ2, etc., and the slope
angle be greater than zero (deg) and less than or equal to 90 (deg).

The various types of searches for failure surfaces are discussed in the following sections.

Specific Failure Surface

Program STABLPRO allows the user to specify a predefined failure surface. To enter the data
for the coordinates of points on the failure surface, Item Specific Failure Surface may be selected from
the dialog box of Failure Surface Search. The input screen will appear as shown in Fig. 3.17. A total of
20 points may be used to define the failure surface. The x and y coordinates are required for each point.

% StablPro 4.0.10 - EXAML1-3 [= ===
File Options  Computation  View Window Help
Title

Slope Boundary Lines
Soil Properties
Water Surface(s)

Surcharge and Earthquake Loading (optional) 2
Trial Surface Limits (optional)

Tiebacks (optional)

Sets of Reinforced Earth Layers (optional)

Failure Surface Search Controls » | v User-Defined Failure Surface
Circular Failure Surface Searched by Janbu's Method
Circular Failure Surface Searched by Bishop's Method

ﬂSpeci‘fy Failure Surface Eﬁ@ At Rt e
Paint |5 Coard. [m) ‘Y Coard. [m] | + Black Search Method (random method)
1 15 15 Spencer's Method
2 17 15.4
3 18.9 159
4 208 16.5
] 227 17.3
E 245 13.2
7 26.2 131
g 2748 202
9 285 21.4
AL 227 il

Add Row Inzert Row Delete Row

B0 poinks masimum

Figure 3.17 Window screen for sample Data — Failure Surface Search/Specific Failure
Surface
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Janbu’s Method

Program STABLPRO can use Janbu’s procedures to search for the failure surface. If the user
selects Item Circular Search-Janbu’s Method from the dialog box of Failure Surface Search,set of text
boxes will appear on the screen, as shown in Fig. 3.18. The geometrical data required by the program can
be easily interpreted by the user with the graphical presentation. A detailed description of the variables is
given in the screen. The graphical sketch on the screen will help the user to visualize the definition of the
variables. After all the data are entered, the screen is closed and the program will return to the Data
menu.

M Search by Janbu's Method = |l = &3

-
L e~ % Cownterclockwise
IS Direclive Limil

Initiation Points
Initiation
Moink

=

Surfaces generated per initigtion paint ====-=--llarizootal

Left initiation *-coordinate, XLi (f) 18t Line Segment

Right initiation *-coordinate, XR.i (ft)
»  Mockwige Nitection
"'\’J Limit

5
5

Lefttermination *-coordination, =Lt {ff) .

Right termination *-coordinate, XR.t(ft)
Tarmination polnts

WLt MR, t
I

Segment length (f)

Minimurm elevation (ft) Initiation points

L1 R,

Counterclockwize limit (deg.)
[Uze - 5 degrees.]

r Minimum elevation of trial surface

a
o

T

Clockwise limit (deg.)
[Uze negative values for Cw limit.)

Figure 3.18 Window screen for sample Data — Failure Surface Search/Janbu’s Method
Surface

Bishop’s Method

Program STABLPRO can use the simplified Bishop’s procedures to search for the failure surface.
If the user selects the item Bishop’s Method from the dialog box of Failure Surface Search, a set of text
boxes will appear on the screen, as shown in Fig. 3.19. The geometrical data required by the program can
be easily entered by the user with the graphicap presentation. A detailed description of the variables is
given in the screen. The input format is similar to the previous screen for Janbu’s method. After all the
data are entered, the screen is closed and the program will return to the Data menu.
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Figure 3.19 Window screen for sample Data — Failure Surface Search/Simplified
Bishop’s Method

Irregular Surface Search by Janbu’s Method

Program STABLPRO can use Janbu’s procedures to search for an irregular failure surface. If the
user selects the Item Irregular Surface Search from the dialog box of Failure Surface Search, a table
will be presented for data entry as shown in Fig. 3.20. A detailed description of the variables is given in
the screen. After all the data are entered, the screen is closed and the program will return to the main
Data menu.
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Figure 3.20 Window screen for sample Data — Failure Surface Search/Irregular Surface
Search by Janbu’s Method

Block Method

Program STABLPRO can use Rankine’s theory to generate the surface of a sliding block. If the
user selects the Item Block Method from the dialog box of Failure Surface Search, a table will appear on
the screen, as shown in Fig. 3.21. The data for-Irregular Surface Search employing Janbu’s Method. The
data fields for each block are provided by grid cells. The definition of each variable is given in detail in
the screen. After all the data are entered, the screen is closed and the program returns to the main Data
menu.
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Figure 3.21 Window screen for sample Data — Failure Surface Search/Block Method

Spencer’s Method

Program STABLPRO can use Spencer’s theory to generate the critical sliding surface. If the user
selects the Item Spencer’s Method from the dialog box of Failure Surface Search, a table will appear on
the screen, as shown in Fig. 3.22. Spencer’s method of slices has been incorporated into STABL5M only
(not available in Program STABL4M) to enhance the versatility of the program.

An estimate of the slope of the interslice forces ( One half the user input slope angle is used by
the program as an initial estimate of the slope of the interslice forces) is the only required input parameter.
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Since significantly more computation time is required for analysis of potential failure surfaces
using Spencer’s method of slices than either the Simplified Janbu or Simplified Bishop methods, the most
efficient use of the STABL5M capabilities will be realized if the user first investigates a number of
potential failure surfaces using one of STABL’s random surface generation techniques which determines
the factor of safety using either the Simplified Janbu or Simplified Bishop method of slices. Once critical
potential failure surfaces have been identified, they may be analyzed using the SPENCR option to obtain
a factor of safety (FOS) satisfying both force and moment i.e., complete equilibrium.

When a user-input potential failure surface is analyzed, the program outputs the value of the factor of
safety with respect to force equilibrium (Fs), the value of the factor of safety with respect to moment
equilibrium (Fm), and the angle of the interslice forces (theta) calculated during iteration, along with the
value of FOS and theta satisfying complete equilibrium. When a user-input potential failure surface is
analyzed, the coordinates of the line of thrust, the ratio of the height of the line of thrust above the sliding
surface to the slice height for each slice, and the values of the interslice forces are all output.

The only input restrictions require that specification of the “SPENCR”option occur prior to specification
of the method of surface generation and solution, i.e., SURFAC, CIRCLZ2, etc., and the slope angle be
greater than zero (deg) and less than or equal to 90 (deg).

rﬂ Search by Spencer's Method ===l
Approximation slope angle with respactto (deg) |22
-"'{-: Moenterclockmise
Initiation Foints 3 Direction Limit
====—-==-Horrzontaol
Surfaces generated per initigtion point 25
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3
.\
b)Y
Right initiation X-coardinate, XF.i (f) &0 *., _Clockwize Directiom
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.‘\
Left termination X-coordination, *Lt (ff) 138 *
Fight termination X-coardinate, <Rt (ff) 170 Terminatien points
¥HLx wR.t
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Segment length (f) 10
Minimum elessation (ft) I Initiation points
LI R, |
L 1
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Figure 3.22 Window screen for sample Data — Failure Surface Search/Simplified
Spencer’s Method
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3.4 Options Menu

3.4.1 Options - Units

This selection provides the user with a choice of input data in English Units, and S.1. Units
(international units) as shown in Figure 3.23. In general, the following specific units of measurements are
used frequently in the program:

Units Length Force Stress/Modulus
English foot (ft) pounds (Ibs) psf
International meters (m) kiloNewtons (kN) kPa

The user should always check the unit descriptions which are associated to each variable in the
program interface. The user may change from one system of units to the other as many times as desired.
The program will automatically convert all the appropriate input that was already specified by the user
before the time of selection of a different system of units. Small conversion errors may appear if multiple
changes of units are performed. The user must always check that input data have been converted
appropriately.

¥ StablPro 4.0.10 - Examd-3 o (][]
File Data Computation  View Window Help
Units » | @ English Units (Ibs, ft)

SI Units (kM, m)
Other Units (F, L)

Text Editor

Figure 3.23 Options for units selection

3.4.2 Options — Text Editor

The user should input in this box (Figure 3.24) the complete path and command line for the
preferred-text editor or word processor that will be used to examine and print the input, output, and the
processor run notes files created by the STABLPRO program.

As a default, the command line c:\windows\notepad.exe is used to operate a standard text editor.
Microsoft Notepad is included with Microsoft Windows XP, VISTA and Windows 7/8. However, the
path to the directory where notepad.exe is installed varies in different versions of the Microsoft Windows
operating system.

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 3 —References for Data Input — 3-26

There may be some instances when the output files are too large for Notepad and a different text
editor or word processor should be used. In those cases it is suggested to use Microsoft WordPad
(c:\windows\wordpad.exe).

% StablPro 4.0.10 - Examd-v3 = =&
File Data Options Computation View Window Help
R Mame of Text Editor Program [= || = [ &3]

Text Editor: |C:¥Windowsinotepad. exe

Browse. ..

Figure 3.24 Options — Control Options

3.5 Help Menu

The Help/Contents submenu starts the standard help interface for guidelines on data input of the
STABLPRO program. The Help/Contents submenu is limited in this program release since better
formatted data is available in the electronic User’s Manual.

The Help/User’'s Manual will start up the default installed version of Adobe Acrobat or Adobe
Reader and open the installed PDF version of the standard User’s Manual of the STABLPRO program.
The Adobe Reader program is freely distributed by Adobe Systems Inc. at www.adobe.com

The Help/Technical Manual will start up a viewer of a protected file for the electronic version of
this manual. The Technical Manual is copyrighted and only works when the proper USB dongle is
connected to the computer in use.

If the Technical Manual is not opening with Acrobat or Reader (while having the proper USB key
connected to the computer in use) then perhaps the Adobe software is not configured correctly. Start
Adobe Reader (or full Adobe Acrobat) then click on "Edit/Preferences"” and "Internet" under
"Categories"”. Please make sure that a check mark is placed under "Display PDF in Browser" then click
OK and exit Reader. You can then try to run the Technical Manual once again.

The Help/About... submenu provides general references about the program (program version, date,
maintenance expiration date, USB serial number) and how to reach Ensoft, Inc. for technical support or
sales.

The Help/Check for Updates submenu will start up the default Internet browser and report the
user of the current program version and maintenance expiration date as well as any new update that is
available for downloading from Ensoft’s website (www.ensoftinc.com). Users will be able to download,
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install and run in full mode any STABLPRO program release that is older than their maintenance
expiration date.
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4.1 Introduction

CHAPTER 4 presents options related to execution of the program and includes methods of
addressing run-time errors. This Chapter also includes suggestions for reviewing input, output, and
processor text files. The final section of this Chapter includes descriptions about all the output curves that
may be observed in graphical form. The commands covered in this chapter are contained in the top menu,
under the Computation and the Graphics titles.

4.2 Computation Menu

This menu option is selected to execute the program using the parameters that were saved in the
input-data file. Within the options contained under this menu, shown in Figure 4.1, there are commands
that facilitate the reviews of the text files produced for storing input data, output results, and processor
notes. In addition, the user may select an option to observe a graphical representation of the modeled pile
and soil layers. Detailed description of the submenu options contained under the Computation menu are
explained in the following topics.

4.2.1 Computation — Run Analysis

The input-data file will be first saved to disk after selecting the Computation — Run Analysis
submenu option, which executes the analytical portion of program STABLPRO.

The user should remember to save the input data under an user-specified name before executing the
analytical module. When saving data to disk, STABLPRO will automatically add an extension of the
type *.ap6d to the name of the input file.

L "

% StablPro 4.0.10 - Exam7-v3 =R ==
File Data Uptiunsh‘im Window Help

Run Analysis

Edit Input Text
Edit Output Text

Error-Message Motes

Figure 4.1 Command options contained in the Computation menu.

When the execution process is finished the active command is returned to the main STABLPRO
program with a screen indicating that computations are completed. The user should always check the
output text file for any error messages that were produced during computations.

At the beginning of the run, the analytical module will read the saved input data progressively. If
an input-data format is incorrect during reading, the analytical module may stop and display an error
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message along with a status report in a file with the same name as the input and with the extension *.sl4r.
This file may be accessed by selecting Edit Processor-Run Notes in the Computation menu. Within the
processor-run notes, if all input data was read correctly, the analytical module will show the message
THE EXECUTION IS IN PROGRESS.

The analytical module automatically creates an output file with the same name as the input and
with the extension *.sl40. This file may be accessed by selecting Edit Output Text in the Computation
menu. Once a successful run is produced, the user may proceed to the next items for observation of
results.

4.2.2 Computation — Edit Input Text

This submenu option is used to edit the input-data file in plain text mode. This command becomes
active after new data files have been saved to disk or when opening existing data files. The command is
helpful for experienced users who may want to change one or two parameters quickly using the text
editor, or for those users wishing to observe the prepared input data in text mode.

This submenu automatically invokes the word processor or text editor specified under
Options/Control Options/Text Editor. The default setting is to use the utility program named notepad.exe
provided by Microsoft Windows®©.

Input-data files are automatically saved to disk with the user-specified file name and the extension
of *.sl4d by program STABLPRO. Use of the notepad program for editing the input data is shown in
Figure 4.2.

4.2.3 Computation - Edit Processor Run Notes

This submenu option is used to edit an intermediate text file that may be produced during each
analytical run. This feature is not used in early editions of STABLPRO but in the future it will include
notes produced during the processing of the input data.

This submenu will automatically invoke the word processor or text editor specified under
Options/Control Options/Text Editor. The default setting is to use the utility program named
notepad.exe provided by Microsoft Windows®©.

Files containing processor-run notes will be automatically saved to disk with the same file name as
the input-data file but with the extension *.sl4r.
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r

| Exam7-v3.5ld - Notepad (o [E@][=]
File Edit Format View Help

FROFIL -
PCSTAELY Ezmample #7

14 6 1

54.9 65.4 67.7 67.1 1
67.7 67,1 72, 9.2 1
F2OR9.2 B0 Y071
a0. 0.7 85. ¥Y5.3 1
gL, 5.3 90.5 78.2 1

90.5 74.2 110. Y8.2 1

54.8 64.9 90.5 88,9 2

90.5 &8.9 110. £8.9 2

54.9 63.1 30.5 60. 3

90.5 &0, 101. 64. 3

101. &4, 110. &3. 3

54.9 57.3 30.5 57.3 4

90.5 &7 .3 101. g2.5 4

101, &2 5 110. E1.5 4

SOIL

4 =
19.6 19.6 47.9 0. 0. 0. 1 1
17.3 17.3 23.9 0. 0. 0. 1

17.3 17.3 3.2 0. 0. 0. 1

196 19 6 0. 35. 0. 0. 1

TATER

1 62.4

3

55, 671
£3. 67.1
110. 70.
TIES

2

2 0. 68, 337, 2.8 0. 60.
a0 700 294 2.8 0. 60
CIRCLZ

10 10

EL. &L, 90. 105.

50. 5. 0. =25

EXECTUT

4 [

Figure 4.2 Sample use of Microsoft Notepad© for editing input text of Example
Problem 7 (may change with time).

4.2.4 Computation — Edit Output Text

This submenu option is used to edit the output-text file that is automatically produced during each
analytical run. This command becomes active after new data files have been saved to disk and
successfully executed, or when opening previously-executed data files.

This submenu will automatically invoke the word processor or text editor specified under
Options/Control Options/Text Editor. The default setting is to use the utility program named
notepad.exe provided by Microsoft Windows®©.

Output files are automatically saved to disk with the same file name as the input-data file but with
the extension *.sl40. Use of Microsoft Notepad®© for editing the output file for Example Problem 1 is
shown in Figure 4.3.
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| B@am7-v3.slo - Notepad = [E=]E2]
File Edit Format VYiew Help
*#% STAELPro V2014 *x -

Upgraded from
FHUA-FCSTAELE

m

—Slope Stability Analvsis—
Simplified Janbu, Simplified Bishop
or Spencer’s Hethod of Slices

Run Date:

Time of Run:

Fun By:

Input Data Filenamns:
Cutput Filenamne:

Flotted Output Filenamnes:

PROELEM DESCRIFTION PCSTABL4 Exanple X7

BOUNDARY COORDINATES

& Top Boundaries
14 Total Boundaries

Boundazry i-Teft Y-Left I-Right Y—Right Soil Type
Ho. ft. ft. ft. ft. E=low End
1 54 .90 68.40 67.70 67 .10 1
2 67 .70 67.10 72.00 69 .20 1
3 7200 £9.20 80.00 70.70 1
4 a0.0o0 70.70 85.00 75 .30 1
5 8500 75.30 90.50 7820 1
g a0, 50 78.20 110.00 78.20 1
7 54 .80 £4.90 90.50 68.90 2
g a0, 50 £8.90 110.00 68.90 2
9 54,90 £3.10 90.50 60.00 3
10 0. 50 60.00 101.00 64.00 3

Figure 4.3 Sample use of Microsoft Notepad © for editing the output-text file of
Example Problem 7 (may change with time).

4.3 View Menu

The View menu is used to observe graphics of output data provided by a successful program run.
Options for the observation of slope geometry, soils layers, and critical failure surface under View menu
are only enabled after a successful run has been made. Even after performing successful runs, some
options may still be disabled since the amount of output data depends on specifications provided in the
input file of each program run. Options of graphics features (Fig. 4.4) are briefly described below.

Most of the graphical representation of input data may be shown on the screen for verification by
checking one or more of the following option boxes.

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 4 —References for Program Execution and Output Reviews — 4-6

,i:;-Ensu:uft Graphics Utility for STABLPro, x= 10307, y = 57.67 - 0| x|

Input Data:

Surface Fressures
Feini. Lines

Move View

Left | Right

Doy

Figure 4.4 Graphics screen and options buttons.

Profile Line

The user may select this check-box option to observe a graphical representation of profile lines for the
slope geometry and soil layers as shown in Fig. 4.5.

Profile Numbers

The user may select this check-box option to observe the profile numbers on the graphical representation
for the slope geometry and soil layers as shown in Fig. 4.5.

Profile Coordinates

The user may select this check-box option to observe the profile coordinates on the graphical
representation for the slope geometry and soil layers as shown in Fig. 4.5.
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L‘ Ensoft Graphics Utility for STABLPro, x=56.32, y=T78.97

=0 %]

Input Data:

Search Liri

905782
(/ )

1

(85.0.75.3)
1

i _(80.0,70.7)
Move Yiew }..-

(r2.0.69.2

.68. A
T

(90.5.68.9)

Left | Right
D owary

Figure 4.5 Graphics presentation for Boundary Line, Soil Layer Number, and Boundary
Coordinates.

Color Soil Layers

The user may select this check-box option to color the soil layers on the graphical representation. It will
provide a better results if the soil layers are not cross-over each others as shown in Fig. 4.6.

Tiebacks

The user may select this check-box option to observe a graphical representation of tieback lines within the
slope geometry and soil layers as shown in Fig. 4.7.

Piezometric Lines

The user may select this check-box option to observe a graphical representation of pierometric surfaces
within the slope geometry and soil layers as shown in Fig. 4.7.
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0] x|

L“,‘ Ensoft Graphics Utility for STABLPro, x=109.01, y = 5441

Figint. Lines
Computed Yalues:
utic

Move View

Left | Right
Down

Figure 4.6 Graphics presentation for soil layers in color.
ol x|

L‘ Ensoft Graphics Utility for STABLPro, x=157.16, y = 55.48

Input Data:

Search Limi

Move View

Left | Right
Down

Figure 4.7 Graphics presentation for Tiebacks and Pierometric lines.
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Surface Pressures

The user may select this check-box option to observe a graphical representation of surface pressure on the
slope boundary. The surface pressure includes the surcharge loads applied on the surface as shown in
Fig. 4.8.

L‘ Ensoft Graphics Utility for STABLPro, x = 4.86, y = 3796 = ]| &

Computed Values:
utian Infa i

Mowve View

Left | Right
Down

Figure 4.8 Graphics presentation for Surface Pressure (Surcharge Load).
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Reinforce Lines

The user may select this check-box option to observe a graphical representation of reinforce layers within
the slope geometry and soil layers as shown in Fig. 4.9.

"

% Ensoft Graphics Utility for STABLPro, x=1076,y=811 = |[E2
A P Y ¥

Input Data:

2 . (1=
Computed Yalues:
Solution Infi i

Total Str
Pore Véater

Move View

Left | Right
Down

Figure 4.9 Graphics presentation for Reinforce Earth Layers

Solution Information

The user may select this check-box option to observe the solution information of the most critical failure
surface.
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10 Critical Slip Surfaces

The user may select this check-box option to observe the 10 most-critical slip surfaces within the slope
boundaries as shown in Fig. 4.10.

ﬂ Ensoft Graphics Utility for STABLPro, x=16.92, y = 465.83

== |82

Factor of Safety = 0.479, X =190.93, Y =299.47, R=287.43

Fuainf. Lines
Computed Values:
in Infarrm

Move View

Left | Right

Down

Figure 4.10 Graphics presentation for 10 critical slip surfaces
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The Most Critical Slip Surface

The user may select this check-box option to observe the most-critical slip surface within the slope
boundaries as shown in Fig. 4.11.

% Ensoft Graphics Utility for STABLPro, x=040,y=46.06 = ][E2
b P Y Y

Input Data:

Factor of Safety =1.629, X=46.00, Y =76.00, R= 0.00

= ESsUrE
int. Lines
Computed Values:

Move View

Left | Right
Down

Figure 4.11 Graphics presentation for the most critical slip surface
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All Trial Slip Surfaces

The user may select this check-box option to observe all the slip surfaces within the slope boundaries as
shwon in Fig. 4.12.

R Ensoft Graphics Utility for STABLPro, x=70.82, y=757.60 = || E2
bt P Y b

Input Data:

Factor of Safety = 1.234, X =78.96, Y =93.11,

Ruint. Lines
Computed Yalues:

Move View

Left | Right
Down

Figure 4.12 Graphics presentation for all trial slip surfaces
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Total Stresses

The user may select this check-box option to observe the distribution of total weight at the bottom of each
slice for the most critical slip surface as shown in Fig. 4.13.

"

R Ensoft Graphics Utility for STABLPro, x=-32.29,y=1016 = || &2
b p ¥ ¥

Input Data:

Factor of Safety = 1.629, X =46.00, ¥ =76.00, R= 0.00

Faint. Lines
Computed Yalues:

Move View

Left | Right
D owary

Figure 4.13 Graphics presentation for the total vertical stresses

Pore Water Pressure

The user may select this check-box option to observe the distribution of pore water pressure at the bottom
of each slice for the most critical slip surface.
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5.1 Introduction

This chapter presents several examples that were solved using STABLPRO. In order to assure
accuracy from the computer results, some examples have been compared with the results from hand
calculations. The step-by-step hand calculations were carried out based on the procedures described in
the accompanying STABLPRO Technical Manual. The users can have confidence in their results if
limited amounts of hand calculations can be done for comparisons. The studies in this chapter also
provide guidance for the analysis of axially loaded piles with STABLPRO.

There are three types of output data provided by the computer. The first type is the output file
which contains formatted text that consists of an echo-print of the input data; the distribution of skin
friction, end bearing, and total capacity; and the final load-settlement curve. The second type of output
presents the data for a graphics file that allows the code to produce plots. All of the data are saved with
ASCII format and the user may access the files with any text editor.

Several problems are provided herein as examples of different applications that may be solved
using our computer program STABLPRO. Each example focuses on a particular computational feature of
the program. Input files for each example are automatically copied to the STABLPRO data directory
during installation (<Root Drive>\Ensoft\STABLPRO2015-Examples).

Example problems provide the user information on input and output of various cases, and present a
quick tutorial for real-world applications. The user is encouraged to study these examples and, with
modifications, may even use them to solve similar problems. However, by no means can these limited
examples explore the full functions and features provided by STABLPRO.

The main features of each example included with STABLPRO are summarized as follows.

Example Problem 1
e long term stability of a cut in a soft clay material

Example Problem 2
e  excavation in a silty sand with vertical sides supported by steel sheet piling,

Example Problem 3
o use of tiebacks for stabilizing an unstable earth slope

Example Problem 4
e analysis of an embankment constructed on soft ground reinforced with 12 layers of
reinforcement
Example Problem 5
e use of tiebacks for stabilizing an unstable earth slope

Example Problem 6
e application with complicated soil conditions

o example with S.I. units.
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5.2 Example Problem 1 (English Units)

The example concerns the long term stability of a cut in a soft clay material (Fig. 8.2). A ground
water table is presented at a depth of about 17 ft below the existing ground surface which gently slopes
toward the cut. An irregular bedrock surface lies at a relatively shallow depth. The variation of the
bedrock surface normal to the plane of the profile is insignificant. Therefore a two-dimensional analysis
is assumed appropriate.

The shear parameters (¢’ = 500 psf, ¢ = 14 deg. ) do not vary significantly with depth, but due to
desiccation, tension cracks are assumed to extend to a depth of approximately 11 feet. By defining the
problem geometry with straight lines, a total of six boundary lines are used for this example. The
boundaries are ordered ground surface boundaries first, left to right, with the single subsurface boundary
last, satisfying program requirements. The 4th and 5th boundaries on the ground surface are above the
tension crack zone, so they are assigned a different soil type number from that assigned to the other
boundaries. The clay below the tension zone has been arbitrarily assigned soil type number 1, which has
the original shear parameters (¢’ = 500 psf, ¢ = 14 deg. ). The clay within the tension zone is soil type
number 2, which has the zero shear parameters (¢’ = 0 psf, ¢ = 0 deg. ) in the analysis.

The bedrock has been assumed competent, with no possibility of failure within it. Therefore,
limits for surface generation boundaries are used to approximate the bedrock surface. Generation of trial
failure surfaces which pass through the bedrock is thus prevented.

The Bishop method will be used for the slope-stability analysis. Searching for the critical surface
will be carried out within 100 trial failure surfaces generated by the program. Only the ten most-critical
failure surfaces will be reported in the output. The input data and output results are given in the following
pages for reference.

b

Figure 5.1 General soil description of Example Problem 1.
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5.2.1 Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 1 is reproduced below in courier
typeface, for distinction.

PCSTABL6 Example #1
6 51

0. 68. 22. 67. 1

22. 67. 38. 63. 1
38. 63. 101. 88. 1
101. 88. 138. 103. 2
138. 103. 205. 110. 2
101. 88. 205. 99. 1
SOIL

2

116.4 124.2 500. 14. 0. 0. 1
116.4 116.4 0. 0. 0. 0. 1
WATERWATER

1 62.4

9

0. 68.

22. 67.

38. 63.

63. 73.

83. 78.

104. 82.

122. 85.

140. 87.

205. 93.

LIMITS

8 8

0. 15. 29. 24.

29. 24. 51. 26.

51. 26. 78. 56.

78. 56. 94. 65.

94. 65. 113. 64.
113. 64. 133. 56.
133. 56. 161. 58.
161. 58. 205. 76.
CIRCL2

5 25

38. 50. 138. 170.

0. 10. 0. =25.
EXECUT

5.2.2 Output Data

Contents of the output-data file for Example Problem 1 is reproduced below in courier typeface, for
distinction.

** STABLPro V4.0*x*

Upgraded from
FHWA-PCSTABLE

1
--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices
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Run Date:

Time of Run:

Run By:

Input Data Filename:
Output Filename:

Plotted Output Filename:

PROBLEM DESCRIPTION PCSTABL6 Example #1

BOUNDARY COORDINATES

5 Top Boundaries
6 Total Boundaries

Boundary X-Left Y-Left X-Right
No. ft. ft. ft.
1 0.00 68.00 22.00
2 22.00 67.00 38.00
3 38.00 63.00 101.00
4 101.00 88.00 138.00
5 138.00 103.00 205.00
6 101.00 88.00 205.00

ISOTROPIC SOIL PARAMETERS

2 Type(s) of Soil
Soil Total Saturated Cohesion Friction
Type Unit Wt. Unit Wt. Intercept Angle
No. pcf pcft psf (deqg)
1 116.4 124.2 500.0 14.0
2 116.4 116.4 0.0 0.0

1 PIEZOMETRIC SURFACE (S) HAVE BEEN SPECIF

Unit Weight of Water = 62.40 pct

Piezometric Surface No. 1 Specified by

X-Water
ft.

Y-Water
ft.

Point
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Y-Right Soil Type
ft. Below Bnd
67.00 1
63.00 1
88.00 1
103.00 2
110.00 2
99.00 1
Pore Pressure Piez.
Pressure Constant Surface
Param. psf No.
0.00 0.0 1
0.00 0.0 1
IED

9 Coordinate Points
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1 0.00 68.00
2 22.00 67.00
3 38.00 63.00
4 63.00 73.00
5 83.00 78.00
6 104.00 82.00
7 122.00 85.00
8 140.00 87.00
9 205.00 93.00
1
Searching Routine Will Be Limited To An Area Defined By 8 Boundaries
Of Which The First 8 Boundaries Will Deflect Surfaces Upward
Boundary X-Left Y-Left X-Right Y-Right
No. ft. ft. ft. ft.
1 0.00 15.00 29.00 24.00
2 29.00 24.00 51.00 26.00
3 51.00 26.00 78.00 56.00
4 78.00 56.00 94.00 65.00
5 94.00 65.00 113.00 64.00
6 113.00 64.00 133.00 56.00
7 133.00 56.00 161.00 58.00
8 161.00 58.00 205.00 76.00
1
A Critical Failure Surface Searching Method, Using A Random
Technique For Generating Circular Surfaces, Has Been Specified.
125 Trial Surfaces Have Been Generated.
25 Surfaces Initiate From Each Of 5 Points Equally Spaced
Along The Ground Surface Between X = 38.00 ft.
and X = 50.00 ft.
Each Surface Terminates Between X = 138.00 ft.
and X = 170.00 ft.
Unless Further Limitations Were Imposed, The Minimum Elevation
At Which A Surface Extends Is Y = 0.00 ft.
10.00 ft. Line Segments Define Each Trial Failure Surface.
Restrictions Have Been Imposed Upon The Angle Of Initiation.
The Angle Has Been Restricted Between The Angles Of -25.0
And 0.0 deg.
1
Following Are Displayed The Ten Most Critical Of The Trial
Failure Surfaces Examined. They Are Ordered - Most Critical
First.
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* * Safety Factors Are Calculated By The Modified Bishop Method * *

Failure Surface Specified By 14 Coordinate Points

Poi

nt

No.

O Joy Ul W

e

10
11
12
13
14

X-Surf
ft.

41.00
50.81
60.77
70.77
80.72
90.55
100.14
109.43
118.32
126.74
134.60
141.83
148.38
150.57

Circle Center At X =

Slice Width
No. Ft

[ee]

[
=
NORFRENWOIdWOWU WO WINOJIN O
NOoYWds 0w dJOdOoOwWwo Uwo oo
eNeoNeoloNeoNoNoNoNeoNoNolololNoNoNoNo o NoNoNo)

* K Kk

1.372

Individual data

Weight
Lbs

.35E+04
.10E+05
.31E+04
.13E+05
.20E+05
.50E+04
.18E+05
.24E+05
.22E+04
.76E+04
.14E+05
.22E+05
.86E+04
.10E+05
.14E+05
.92E+03
.55E+04
.32E+04
.19E+04
.48E+04
.37E+03

eNoNeoloNoNeoNoNeoNoNeoNoNoNeoloNeoNoNoNoNoNeoNo)

Water
Force
Top
Lbs
.17E+02
.38E+02
.11E+02
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

Y-Surf
ft.

64.
62.
61.
61.
62.
64.
66.
70.
75.
80.
86.
93.
101.
104.

66.0 ;

on the

Water

Force

Bot

Lbs

.18E+04
.52E+04
.16E+04
.61E+04
.90E+04
.22E+04
. 74E+04
.93E+04
.82E+03
.28E+04
.47E+04
.67E+04
.23E+04
.22E+04
.14E+04
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

ecNeoNeoleoNeoNoNoNeoNeolNoNolololNoNoNoNo o NoNoNo)
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19
27
30
27
20
08
89
60
17
58
76
66
22
31

Y

21

165.9

slices

Tie

Force
Norm

eNeoNeoloNeoNoNoNoNeoNoNoNololNoNoNoNo oo NoNo)

Lbs

.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

and Radius,

Tie
Force
Tan
Lbs

eNeoNeoleoNoNoNoNoNeolNoNolNololNoNoNoNo oo NoNo)

eNeoNeoBeoNoNoNoNoNeoNololololNoNoNoNo oo NoNe)

104.7

Earthquake
Force Surcharge

Hor
Lbs

o

eNoNeoloNeoNeoNoNoNoNeoNoNoNeoloNeoNoNoNoNoNo]

eNoNeoloNeoNeoNoNoNoNeoNoNoNeoloNeoNoNoNo oo No)

Ver Load
Lbs Lbs

(@]
o

cNeoNeoloNoNoNoloNeolNoNololoNoNoNololNoNeNol
eNeoNeoloNoNoNoNoNeoNoNolololNoNoNoNo o NoNoNo)
O OO OO0 Ooooo
O OO OO0 Ooo oo
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CHAPTER 5 - Example Problem 8 — 5-8

Failure Surface Specified By 14 Coordinate Points

Point X-Surf
No. ft.
1 38.00
2 47.91
3 57.89
4 67.89
5 77.83
6 87.67
7 97.32
8 106.73
9 115.84
10 124.59
11 132.93
12 140.80
13 148.15
14 154.72

Circle Center At

*xox 1.374

Y-Surf
ft.

63.
61.
61.
61.
62.
64.
66.
70.
74.
79.
84.
90.
97.
104.

* K Kk

00
64
08
32
36
19
80
18
30
14
66
84
62
75

Failure Surface Specified By 14

Point X-Surf
No. ft.
1 41.00
2 50.86
3 60.83
4 70.83
5 80.79
6 90.63
7 100.29
8 109.70
9 118.77
10 127.406
11 135.68
12 143.39
13 150.53
14 155.89

Circle Center At

*xK 1.374

Y-Surf
ft.

64.
62.
61.
61.
62.
64.
67.
70.
74.
79.
85.
91.
98.
104.

* K k

19
53
72
76
67
42
00
41
61
57
25
62
62
87

Failure Surface Specified By 14

Point
No.

X-Surf

ft.

Y-Surf
ft.
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Coordinate Points

= 178.3 and Radius,

Coordinate Points
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CHAPTER 5 - Example Problem 8 — 5-9

O J oy U W

e}

10
11
12
13
14

38.
47.
57.
67.
77.
87.
97.
106.
.92
123.
130.
137.
143.
144.

114

Circle Center At

00
80
74
74
69
48
02
19

10
66
51
58
33

*xox 1.374

63.
60.
59.
59.
61.
63.
66.
70.
.93

80.

87.

94.
102.
103.

74

* K Kk

00
99
98
99
02
05
07
04

67
22
51
45
66

Failure Surface Specified By 15

Point X-Surf
No. ft.
1 41.00
2 50.89
3 60.87
4 70.87
5 80.83
6 90.71
7 100.43
8 109.94
9 119.19
10 128.13
11 136.69
12 144.83
13 152.50
14 159.66
15 162.28

Circle Center At

*xK 1.377

Y-Surf
ft.

64.
62.
62.
62.
62.
64.
66.
69.
73.
78.
83.
89.
95.
102.
105.

* % %

19
72
01
06
89
47
81
88
68
18
34
15
57
55
54

Failure Surface Specified By 14

Point X-Surf

No ft.
1 38.00
2 47.84
3 57.81
4 67.81

Y-Surf
ft.

63.
61.
60.
60.

User’s Manual (Rel. October/2015)

00
23
40
53

= 158.0 and Radius,

Coordinate Points

= 192.2 and Radius,

Coordinate Points

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC

98.2

130.3

STABLPRO for Windows
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0 J oy U

9
10
11
12
13
14

77.

87.

97.
106.
115.
123.
131.
138.
144.
1l46.

Circle Center At

* k%

75
54
09
31
13
45
20
31
71
13

1.378

61.
63.
66.
70.
75.
80.
87.
94.
101.
103.

* k%

62
65
62
48
20
75
07
10
78
85

Failure Surface Specified By 16

Point X-Surf
No. ft.
1 38.00
2 47.94
3 57.94
4 67.93
5 77.89
6 87.78
7 97.54
8 107.14
9 116.55
10 125.71
11 134.60
12 143.17
13 151.39
14 159.22
15 166.64
16 167.82

Circle Center At

* % %

1.384

Y-Surf
ft.

63.
61.
61.
61.
62.
64.
66.
69.
72.
76.
81.
86.
91.
98.
104.
106.

* % %

00
95
54
77
66
18
34
13
53
54
12
28
97
19
90
12

Failure Surface Specified By 14

Point
No.

W Joy Ul wN

X-Surf

ft.

41.
50.
60.
70.
80.
90.

100
109

00
89
86
86
81
65
.30
.69

Y-Surf
ft.

64.
62.
62.
62.
63.
64.
67.
71.

User’s Manual (Rel. October/2015)

19
68
00
15
14
95
58
00

= 164.7 and Radius,

Coordinate Points

= 216.1 and Radius,

Coordinate Points

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC

104.4

154.6

STABLPRO for Windows
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9
10
11
12
13
14

118.
127.
135.
143.
150.
155.

Circle Center At

77
47
72
48
68
80

* kK 1.386

75.
80.
85.
92.
99.
104.

* K Kk

19
13
78
09
03
86

Failure Surface Specified By 14

Point X-Surf
No. ft.
1 44.00
2 53.82
3 63.77
4 73.77
5 83.73
6 93.57
7 103.21
38 112.56
9 121.54
10 130.08
11 138.11
12 145.54
13 152.34
14 155.35

Circle Center At

*xK 1.387

Y-Surf
ft.

65.
63.
62.
62.
63.
65.
67.
.29

75.

80.

86.

93.
100.
104.

71

* % %

38
48
50
44
30
07
74

69
89
86
54
88
81

Failure Surface Specified By 15

Point X-Surf
No. ft.
1 41.00
2 50.91
3 60.90
4 70.90
5 80.85
6 90.69
7 100.37
8 109.84
9 119.02
10 127.87
11 136.34
12 144 .37
13 151.92
14 158.94

Y-Surf
ft.

64.
62.
62.
62.
63.
65.
67.
71.
74.
79.
84.
90.
97.
104.

User’s Manual (Rel. October/2015)

19
87
32
53
52
27
77
01
97
62
94
90
46
58

= 181.8 and Radius,

Coordinate Points

= 170.8 and Radius,

Coordinate Points
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CHAPTER 5 — Example Problem 8 — 5-12

15 159.51 105.25
Circle Center At X = 63.1 ; Y = 192.1 and Radius, 129.8
* K x 1'393 * x %

5.2.3 Graphical Results of Computer Analysis

The critical failure surface was marked in red and the factor of safety is 1.372. It is very useful for
the user to plot another 10 most-critical slip surfaces, or all trial surfaces together for comparison as
shown in Error! Reference source not found..

,L‘ Ensoft Graphics Utility for STABLPro, x=19674, y = 2745 =] &8

Factor of Safety =1.372, X =66.00, Y

Move Yiew

Left | Right
D owvin

Figure 5.2 Plot of the most critical failure surface and other trial surfaces of Example
Problem 1.

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



CHAPTER 5 — Example Problem 8 — 5-13

The use may add the distribution curves of the total normal stress as well as the pore water pressure
in the same plot for study as shown in Figure 5.3.

L‘ Ensoft Graphics Utility for STABLPro, x= 9242, y = 22.87 =
p [lata

v Zoom In Zoarm Out Zoom Al

v

=

-

-

[ Factor of Safety = 1.372, X=66.00, Y ¥ 165.90, R =104~4

v

-

-

<R <<l <<

Up 1
Left | Right
Down 1 — 1 -

Yo
Print i

Cloze

Figure 5.3 Plot of the most critical failure surface and the distribution of stresses of
Example Problem 1.
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CHAPTER 5 — Example Problem 8 — 5-14

5.3 Example Problem 2 (Sl Units)

The profile shown in Fig. 5.4 represents a proposed excavation in a silty sand with vertical sides
supported by steel sheet piling. It has been determined that the critical failure surface is circular and exits
the slope at the toe of the sheeting. The minimum factor of safety for overall stability was 0.71 without
using any tiebacks.

Two rows of tiebacks are required for local stability of the wall. The first (top) row of tiebacks
will be horizontal and the free length of the tiebacks will be 13 m. The first row of tiebacks will each
carry a load of 660 kN and will be spaced 10 m apart horizontally. The second (lower) row of tiebacks
will be inclined 15 degrees as measured clockwise from the horizontal and will have a free length of 10
m. Each tieback in this row will carry a load of 900 kN and will also be at a 10 m horizontal spacing.
Both rows of tiebacks will transfer their loads to the sheeting using horizontal steel beams for Wales.

Therefore, the assumption of a uniform distribution of load between the tiebacks will be
reasonable for this case since the action of the wale will cause an equivalent horizontal line load to be
formed for each row of tiebacks. It is desired to know what effect the tiebacks have on the factor of
safety of the previously mentioned critical failure surface. Therefore, the program will be run using a
specified circular failure surface. The input data and output results are given in the following pages for
reference.

Zo
@
/s e
oo kN . 71 L f3m VSRS
sobv_ ' @ A—————
T2 ¥
fo C-‘ /04,
15°
vV_@D
Y - Axis (m) Z
5
0 .
0 5 /0 /5 20 25 320
X - Axis (m)
Figure 5.4 General soil description of Example Problem 2.
User’s Manual (Rel. October/2015) STABLPRO for Windows
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CHAPTER 5 — Example Problem 8 — 5-15

5.3.1 Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 2 is reproduced below in courier
typeface, for distinction.

PROFIL

Example 2 with tieback
4 4 2

0. 8. 12. 8. 1

12. 8. 12.1 15. 1

12.1 15. 15. le6. 1

15. 16. 30. 16. 1

SOIL

1

19.63 20.41 4.79 28. 0. 0. 1
WATER

1 9.81

4

0. 8.

12. 8.

12.05 12.

30. 12.

TIES

2

2 0. 13. 660. 10. 0. 13.
2 0. 11. 900. 10. 15. 10.
SURFAC

8

12. 8.

13.8 8.9

15.5 10.

17. 11.3

18.5 12.65

19.75 14.2

20.9 15.8

21. 1le.

EXECUT

5.3.2 Output Data

Contents of the output-data file for Example Problem 2 is reproduced below in courier typeface, for
distinction.

** STABLPro V4.0**

Upgraded from
FHWA-PCSTABLE

--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices

Run Date:

Time of Run:

Run By:

Input Data Filename:
Output Filename:

User’s Manual (Rel. October/2015) STABLPRO for Windows
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CHAPTER 5 — Example Problem 8 — 5-16

Plotted Output Filename:

PROBLEM DESCRIPTION Example 2 with tieback

BOUNDARY COORDINATES

4 Top Boundaries
4 Total Boundaries

Boundary X-Left Y-Left X-Right Y-Right Soil Type
No. M M M M Below Bnd

1 0.00 8.00 12.00 8.00 1

2 12.00 8.00 12.10 15.00 1

3 12.10 15.00 15.00 16.00 1

4 15.00 16.00 30.00 16.00 1

ISOTROPIC SOIL PARAMETERS

1 Type(s) of Soil

Soil Total Saturated Cohesion Friction Pore Pressure Piez.
Type Unit Wt. Unit Wt. Intercept Angle Pressure Constant Surface
No. kN/M"3 kN/M"3 kPa (deg) Param. kPa No.

1 19.6 20.4 4.8 28.0 0.00 0.0 1

1 PIEZOMETRIC SURFACE (S) HAVE BEEN SPECIFIED

Unit Weight of Water = 9.81 kN/M"3
Piezometric Surface No. 1 Specified by 4 Coordinate Points
Point X-Water Y-Water
No M M
1 0.00 8.00
2 12.00 8.00
3 12.05 12.00
4 30.00 12.00

TIEBACK LOAD (S)

User’s Manual (Rel. October/2015) STABLPRO for Windows
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CHAPTER 5 — Example Problem 8 — 5-17

2 Tieback Load(s) Specified

Tieback X-Pos Y-Pos Load Spacing Inclination Length
No. M M KN M (deg) M

1 12.07 13.00 660.0 10.0 0.00 13.0

2 12.04 11.00 900.0 10.0 15.00 10.0

NOTE - An Equivalent Line Load Is Calculated For Each Row Of Tiebacks
Assuming A Uniform Distribution Of Load Horizontally Between
Individual Tiebacks.

Trial Failure Surface Specified By 8 Coordinate Points

Point X-Surf Y-Surf

No. M M
1 12.00 8.00
2 13.80 8.90
3 15.50 10.00
4 17.00 11.30
5 18.50 12.65
6 19.75 14.20
7 20.90 15.80
8 21.00 16.00

Factor Of Safety For The Preceding Specified Surface = 1.224

5.3.3 Graphical Results of Computer Analysis

The factor of safety for the same specified failure surface without tiebacks is 0.71. The factor of
safety for the specified failure surface increases to 1.224 with the tieback as shown in Figure 5.5. There
are several parameters related to tiebacks, which may alter the factor of safety. Those parameters include
the tieback loads, the tieback spacing, and the free length of the tieback. It is very useful for the user to
conduct some parametric studies for understanding those influences.
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CHAPTER 5 — Example Problem 8 — 5-18

L‘ Ensoft Graphics Utility for STABLPro, x=10.73, y=16.26 = || £2

Input Data:

Factor of Safety = 1.220

Surface Prassures
Reinif. Lines
Computed Yalues:
alution Infa i

Taital Sire
F:.

Move View

Left | Right
Down

Figure 5.5 Plot of the failure surface with two tiebacks of Example Problem 2.
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CHAPTER 5 — Example Problem 8 — 5-19

5.4 Example Problem 3 (Block Failure)

The third example problem demonstrates the use of tiebacks for stabilizing an unstable earth slope.
The slope profile is shown in Fig. 5.6 and consists of a layer of compacted fill overlying a till deposit.
Above the bedrock and below the till layer is a weak clay layer through which the slide movement is
occurring. The crest of the slope is subjected to an inclined surcharge load of 100 psf and a vertical
surcharge load of 200 psf. In addition, a portion of the slope is saturated by a groundwater table.

The slope has been moving for several years and it appears that the failure is a sliding block type
failure and that the failure surface passes through the weak clay stratum and exits near the toe of the
slope. One solution to this problem is to install a single row of tiebacks into the slope which anchor into
the bedrock. The anchor are placed at a horizontal spacing of 10 feet and are inclined at an angle of 40
degrees as measured from the horizontal. Each tieback is 45 ft long and carries a load of 300,000 lIbs and
bears against a 6 ft by 6 ft by 3 ft reinforced concrete pad.

The Block method will be used for the slope-stability analysis. Searching for the critical surface
will be carried out within the weak layer defined by the blocks. The critical factor of safety for the
overall stability of the tieback slope is over 1.5. The input data and output results are given in the
following pages for reference.

o

T3] _

o

w

. 200 psf
100 psE 77777777 H

o | foot = 0.3048 metres P !

(=N I pcf = 16.02 kg/m

S | psf = 4.88 kg/m?

in 1 1b = 0.454 kg
P
IS
4 o ¥,
hd n

F 0.02

5 300,000 1bs L

elismic

&9 Coefficients
< o 0.02
( D

Lﬂ‘“
I o
>_

o]

N

[,:ll L = 45 ft (Unbonded Length)

H = 10 ft (Horizontal Spacing)
o TIEBACK EXAMPLE PROBLEM #3
| 1 1 1 1 1 l |
0 12. 50 25. 00 37.50 50. 00 62. 30 75. 00 87.50 100, 00
Figure 5.6 General soil description of Example Problem 3.
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CHAPTER 5 — Example Problem 8 — 5-20

5.4.1 Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 3 is reproduced below in courier
typeface, for distinction.

PROFIL

TIEBACK EXAMPLE PROBLEM #3
14 8 1

0. 24. 12. 24. 2

12. 24. 19.5 30. 2

19.5 30. 19.6 31.5 5

19.6 31.5 22.5 34. 5

22.5 34. 24. 34. 5

24. 34. 34. 42. 2

34. 42. 46. 52. 1

46. 52. 100. 52. 1

34. 42. 100. 42. 2

24. 34. 25.5 32.5 5

19.5 30. 20.8 28.6 2

20.8 28.6 25.5 32.5 2

0. 16. 100. 25. 3

0. 8. 100. 20. 4

SOIL

5

120. 125. 400. 26. 0. 0. 1
122. 127. 850. 30. 0. 0. 1
115. 120. 475. 0. 0. 0. 1
144. 147. 0. 45. 0. 0. 1
150. 150. 0. 0. 0. 0. 1

ANISO

1

22

-30. 600. 34.
90. 300. 28.
WATER

1 62.4

8

0. 24.

12. 24.

26. 30.

38. 34.

49. 37.

58. 39.

70. 40.

100. 40.
LOADS

2

50. 56. 100. 10.

56. 66. 200. O.
EQUAKE

0.02 0.02 0.00

TIES

1

4 0. 32.5 300000. 10. 40. 45.
BLOCK

25 2 6.

22. 14.5 24. 14.5 7.
70. 19.5 72. 19.5 5.
EXECUT
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5.4.2 Output Data

Contents of the output-data file for Example Problem 3 is reproduced below in courier typeface, for

Y-Right
ft.

24.
30.
31.
34.
34.
42.
52.
52.
42.
32.
28.
32.
25.
20.

distinction.
** STABLPro V4.0**
Upgraded from
FHWA-PCSTABLE
1
--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices
Run Date:
Time of Run:
Run By:
Input Data Filename:
Output Filename:
PROBLEM DESCRIPTION TIEBACK EXAMPLE PROBLEM #3
BOUNDARY COORDINATES
8 Top Boundaries
14 Total Boundaries
Boundary X-Left Y-Left X-Right
No. ft. ft. ft.
1 0.00 24.00 12.00
2 12.00 24.00 19.50
3 19.50 30.00 19.60
4 19.60 31.50 22.50
5 22.50 34.00 24.00
6 24.00 34.00 34.00
7 34.00 42.00 46.00
8 46.00 52.00 100.00
9 34.00 42.00 100.00
10 24.00 34.00 25.50
11 19.50 30.00 20.80
12 20.80 28.60 25.50
13 0.00 16.00 100.00
14 0.00 8.00 100.00
1

ISOTROPIC SOIL PARAMETERS

5 Type(s) of Soil

User’s Manual (Rel. October/2015)
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CHAPTER 5 — Example Problem 8 — 5-22

Soil Total Saturated Cohesion Friction Pore Pressure Piez.
Type Unit Wt. Unit Wt. Intercept Angle Pressure Constant Surface
No. pct pct psft (deg) Param. psft No.

1 120.0 125.0 400.0 26.0 0.00 0.0 1

2 122.0 127.0 850.0 30.0 0.00 0.0 1

3 115.0 120.0 475.0 0.0 0.00 0.0 1

4 144.0 147.0 0.0 45.0 0.00 0.0 1

5 150.0 150.0 0.0 0.0 0.00 0.0 1

ANISOTROPIC STRENGTH PARAMETERS
1 soil type(s)

Soil Type 2 Is Anisotropic

Number Of Direction Ranges Specified = 2
Direction Counterclockwise Cohesion Friction
Range Direction Limit Intercept Angle
No. (deg) pst (deqg)
1 -30.0 600.0 34.0
2 90.0 300.0 28.0
1
1 PIEZOMETRIC SURFACE (S) HAVE BEEN SPECIFIED
Unit Weight of Water = 62.40 pct
Piezometric Surface No. 1 Specified by 8 Coordinate Points
Point X-Water Y-Water
No. ft. ft.
1 0.00 24.00
2 12.00 24.00
3 26.00 30.00
4 38.00 34.00
5 49.00 37.00
6 58.00 39.00
7 70.00 40.00
8 100.00 40.00
1
BOUNDARY LOAD(S)
2 Load(s) Specified
Load X-Left X-Right Intensity Deflection
No. ft. ft. psft (deg)
User’s Manual (Rel. October/2015) STABLPRO for Windows
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CHAPTER 5 — Example Problem 8 — 5-23

1 50.00 56.00 100.0 10.0
2 56.00 66.00 200.0 0.0

NOTE - Intensity Is Specified As A Uniformly Distributed
Force Acting On A Horizontally Projected Surface.

A Horizontal Earthquake Loading Coefficient
0f0.020 Has Been Assigned

A Vertical Earthquake Loading Coefficient
0f0.020 Has Been Assigned

Cavitation Pressure = 0.0 pst
1
TIEBACK LOAD (S)
1 Tieback Load(s) Specified
Tieback X-Pos Y-Pos Load Spacing Inclination Length
No. ft. ft. lbs ft. (deg) ft.
1 20.76 32.50 300000.0 10.0 40.00 45.0
NOTE - An Equivalent Line Load Is Calculated For Each Row Of Tiebacks
Assuming A Uniform Distribution Of Load Horizontally Between
Individual Tiebacks.
1
A Critical Failure Surface Searching Method, Using A Random
Technique For Generating Sliding Block Surfaces, Has Been
Specified.
25 Trial Surfaces Have Been Generated.
2 Boxes Specified For Generation Of Central Block Base
Length Of Line Segments For Active And Passive Portions Of
Sliding Block Is 6.0
Box X-Left Y-Left X-Right Y-Right Height
No. ft. ft. ft. ft. ft.
1 22.00 14.50 24.00 14.50 7.00
2 70.00 19.50 72.00 19.50 5.00
1
Following Are Displayed The Ten Most Critical Of The Trial
Failure Surfaces Examined. They Are Ordered - Most Critical
User’s Manual (Rel. October/2015) STABLPRO for Windows
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Slice
No.
1

QO J oy Ul b WN

9
10
11
12
13
14
15
16
17
18
19
20
21
22
23

Width

B ONOIHF WO 0O O OOUU OO

Fi

rst.

* * Safety Factors Are Calculated By The Modified Janbu Method * *

Failure Surface Specified By 14 Coordinate Points

Ft

N

OO OO OCOOOOOUU i JINF OWOoWOU b

Point
No.

O ~J oy U W

e
B W E O W

* % %

Individual data

Weight

Lbs
.89E+02
.18E+04
.35E+04
.31E+03
.72E+03
.81E+04
.16E+04
.20E+03
.28E+04
.46E+04
.12E+04
.32E+04
.43E+04
.15E+04
.26E+05
.15E+05
.33E+05
.13E+05
.44E+04
.26E+05
.84E+04
.33E+05
.16E+05

loNeoleoNeoNoNoNoloNolololNolNoNoNololoNoNolo o NoNol

[eNeoNeoNeoNoNeoNoNoNolNoloNoNeoNoNoNeo oo No o No o Ne]

X-Surf
ft.

12.76
18.64
22.90
71.19
74.55
76.58
80.62
83.85
86.37
90.15
90.45

1.629

Water
Force
Top
Lbs
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

Y-Surf
ft.

24.
22.
18.
l6.
15.
11.
21.
25.
31.
36.
41
46.
51.
52.

on the

Water
Force
Bot
Lbs
.61E+02
.12E+04
.18E+04
.16E+03
.37E+03
.36E+04
.91E+03
.11E+03
.14E+04
.23E+04
.61E+03
.12E+04
.17E+04
.58E+03
.95E+04
.50E+04
.10E+05
.39E+04
.13E+04
.79E+04
.26E+04
.10E+05
.50E+04

loNeoleoNeoNoNoNoleoNoBololNolNoNoNololoNoNolo oo ol
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00
84
72
64
46
24
02
99
63
07

.13

57
23
00

ool eoNeoNoNoNoloNeolNoNololNoNoNoNol

3

4 slices

Tie

Force
Norm

0.
0.
0.

Lbs

00E+00
00E+00
13E+02
.47E+02
.25E+02
.21E+03
.38E+03
.46E+02
.59E+03
.91E+03
.22E+03
.43E+02
.94E+01
.11E+02
.12E+04
.12E+04
.29E+04
.11E+04
.36E+03
.20E+04
.64E+03
.23E+04
.10E+04

Tie

Force

Tan
Lbs

0.
0.
-13.
-47.
25.
-211.
379.
46.
590.
912.
224.
-43.

11.
1218.
1198.
2891.
1090.

357.
2049.
640.
2338.
1044.

WWwNhoowwowokr OB OO UILOLTO P OF OO

Earthquake
Force Surcharge
Hor Ver Load
Lbs Lbs Lbs
1.8 1.8 0.0
35.6 35.6 0.0
70.2 70.2 0.0
6.2 6.2 0.0
14.4 14.4 0.0
161.1 1e6l.1 0.0
31.4 31.4 0.0
4.1 4.1 0.0
55.8 55.8 0.0
91.4 91.4 0.0
23.3 23.3 0.0
63.5 63.5 0.0
86.6 86.6 0.0
29.2 29.2 0.0
518.1 518.1 0.0
295.1 295.1 0.0
663.7 663.7 0.0
265.1 265.1 0.0
87.4 87.4 0.0
514.5 514.5 600.0
167.7 167.7 400.0
651.3 651.3 1600.0
313.9 313.9 0.0
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CHAPTER 5 — Example Problem 8 — 5-25

24 1.2 0.46E+04
25 1.0 0.38E+04
26 2.4 0.81E+04
27 2.0 0.58E+04
28 4.0 0.90E+04
29 2.5 0.42E+04
30 0.7 0.99E+03
31 0.4 0.51E+403
32 2.1 0.20E+04
33 3.8 0.14E+04
34 0.3 0.14E+02

eNoNeoBoNeoNoNoNolNoNeoNo)

.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

.14E+04
.20E+04
.41E+04
L42E+04
.23E+04
.57E+03
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

O OO OO0 OO oo

O OO OO0 OO oOo

.30E+03
.18E+03
.44E+03
.37E+03
.83E+03
.50E+03
.14E+03
.84E+02
.44E+03
.63E+03
.60E+02

295.
175.
442.
373.
825.
503.
141.

83.
435.
626.

[ W=l \C RN REN BTSN o) BN RN G TS

91.
75.
162.
116.
179.
84.
19.
10.
39.
28.

Failure Surface Specified By 14 Coordinate Points

Point
No.

O J o U wN

e
S W R oW

* K Kk

X-Surf
ft.

13.67
19.51
23.92
70.78
73.93
77.80
80.90
83.19
87.43
89.72
89.75

1.716

Y-Surf
ft.

24.
23.
19.
17.
16
12
21.
26.
31.
36
42
46.
51.
52.

00
30
36
71

.33
.26

78
89
48

.61
.16

41
95
00

Failure Surface Specified By 12

Point
No.

O J oUW N

o e
N RO

* K Kk

X-Surf
ft.

12.73
18.26
23.45
70.13
74.12
75.22
78.08
79.41
82.09
85.18

1.838

Y-Su

rf

ft.

24.
21
17
15.
12.
21.
26.
32
37.
43.
48.
52.
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00

.83
.68

37
34
63
11

.01

28
13
50
00

Coordinate Points

WEFE Wk WU o o

91.6 0.0
75.1 0.0
162.6 0.0
116.8 0.0
179.5 0.0
84.9 0.0
19.8 0.0
10.1 0.0
39.3 0.0
28.1 0.0

0.3 0.0
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CHAPTER 5 — Example Problem 8 — 5-26

Failure Surface Specified By 12 Coordinate Points

Point X-Surf Y-Surf
No. ft. ft.
1 9.01 24.00
2 9.46 23.64
3 13.71 19.41
4 18.55 15.87
5 22.85 11.68
6 71.40 21.22
7 74.46 26.38
8 75.85 32.21
9 79.15 37.23
10 80.69 43.03
11 84.08 47.97
12 88.10 52.00
* k% 1.912 * k%

Failure Surface Specified By

12

Point X-Surf Y-Surf

No. ft. ft.
1 8.24 24.00
2 9.55 22.90
3 14.30 19.23
4 18.80 15.26
5 23.19 11.17
6 70.87 20.35
7 73.11 25.92
8 74.48 31.76
9 78.51 36.19

10 82.76 40.44

11 84.19 46.26

12 85.70 52.00

* Kk x 1.913 * Kk x

Failure Surface Specified By

13

Point X-Surf Y-Surf

No. ft. ft.
1 3.31 24.00
2 6.76 22.34
3 11.11 18.21
4 16.89 16.58
5 22.69 15.08
6 70.99 20.51
7 72.93 26.19

Coordinate Points

Coordinate Points
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8 74.01 32.09

9 78.25 36.34

10 81.32 41.50

11 85.35 45.94

12 88.45 51.08

13 89.22 52.00
* K Kk 1-928 * K Kk

1
Failure Surface Specified By 14 Coordinate Points

Point X-Surf Y-Surf

No. ft. ft.
1 1.21 24.00
2 1.57 23.65
3 7.46 22.48
4 11.78 18.31
5 17.51 16.55
6 23.20 14.66
7 70.98 19.27
8 72.76 25.00
9 74.00 30.87
10 77.71 35.59
11 81.47 40.26
12 85.47 44.74
13 89.25 49.39
14 90.11 52.00

* k% l . 973 * % %
Failure Surface Specified By 13 Coordinate Points

Point X-Surf Y-Surf

No ft. ft
1 3.22 24.00
2 6.80 20.96
3 12.75 20.21
4 17.04 16.01
5 22.99 15.20
6 70.02 20.28
7 73.35 25.27
8 77.13 29.93
9 78.25 35.83
10 82.46 40.10
11 86.70 44.34
12 90.91 48.61
13 92.66 52.00

* % % 1 . 989 * % %
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Failure Surface Specified By 13 Coordinate Points

Point X-Surf Y-Surf
No. ft. ft.
1 6.85 24.00
2 7.82 23.38
3 12.46 19.58
4 16.85 15.49
5 22.17 12.72
6 70.46 17.95
7 74.45 22.43
8 78.67 26.71
9 78.99 32.70
10 81.62 38.09
11 83.45 43.81
12 86.06 49.21
13 86.84 52.00
* k% 2.042 * k%

Failure Surface Specified By 13 Coordinate Points

Point X-Surf Y-Surf
No. ft. ft.
1 12.27 24.22
2 13.41 23.24
3 17.68 19.02
4 22.25 15.14
5 70.58 18.20
6 74.39 22.83
7 78.58 27.13
8 82.82 31.37
9 86.68 35.97
10 88.62 41.64
11 92.58 46.15
12 96.80 50.42
13 98.36 52.00
* Kk x 2.143 * Kk x

5.4.3 Graphical Results of Computer Analysis

The factor of safety for the same specified failure surface without tiebacks is 1.113. The factor of
safety for the specified failure surface increases to 1.629 with the tieback as shown in Figure 5.7.
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W Ensoft Graphics Utility for STABLPro, x=58.97 y=7210 = || 2
bt P Y Y

Input Data:

Factor of Safety = 1.629, X =46.00, ¥ =76.00, R= 0.00

Move Yiew

Left | Right
Down

Figure 5.7 Plot of the block-failure surface with tiebacks of Example Problem 3.
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5.5 Example Problem 4 (Reinforce Earth Slope)

The fourth example problem demonstrates the analysis of an embankment constructed on soft
ground reinforced with 12 layers of reinforcement. The slope profile is shown in Fig. 5.8. The
embankment soil has been arbitrarily assigned soil type number 1, which has the weak shear parameters
(¢’ =5.79 kPa, ¢ = 27 deg, and y = 19.63 kN/m?®). The foundation soil below the embankment is soil
type number 2, which has little stronger shear parameters (¢’ = 9.58 kPa, ¢ = 30 deg, and y = 18.84
KN/m3).

Tensile reinforcing layers provide a resisting moment which increases the embankment stability.
This effect was incorporated into the simplified Bishop method. The methodology of considering the
resistance components from the reinforcing layers can be found in the technical manual. To use the
reinforcing option, the location of each layer is specified by a series of X, y coordinates starting at the left
end of the reinforcement and moving to the right as indicated in Fig. 3.15. In a typical application the left
end of the layer would be at the embankment toe or the face of the slope and would extend across the full
width of the embankment.

The available force and orientation of the force is specified at each point defining the reinforcing
layer. The orientation of the force is specified by the inclination factor. The inclination factor varies from
0.0 which specifies that the force acts in the direction of the reinforcement to 1.0 which specified that it
acts normal to the slip surface. The Simplified Bishop method will be used for the slope-stability analysis
either on the user-specified slip surface or the trial surfaces generated by the program.

A

_ s A T !
25 / _ S Rl
pd RO .
i N

Sal L Y 1003 kNAS : o T

2 o 2ot kNA? — £ _l.¢1_..___...ﬂ.-s.ﬁ__, I
. ¢ 5sM wWa ‘I .. _.F4 e e e

¢ M dy e -
s - T R’E o .

& Soil #2. Y 188
0 Jo .is 19.63
3 & 98
. P 3o
p‘.
5 Lineits )
. .
o 5 Jo 3 20 2s 3 3s o
' ' A- AYS (m)
Figure 5.8 General soil description of Example Problem 3.
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5.5.1 Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 4 is reproduced below in courier
typeface, for distinction.

PROFIL

Example 4 Embankment with reinforcing layers
4 31

0. 15. 15. 15. 2
15. 15. 28. 28. 1
28. 28. 45. 28. 1
15. 15. 45. 15. 2
SOIL

2

19.63 20.41 5.79 27. 0. 0. 1
18.84 19.63 9.58 30. 0. 0. 1
LIMITS

11

0. 5. 45. 5.
REINF

12

3

15. 15. 0. 0.

19. 15. 7.295 0.
45. 15. 7.295 0.
3

16. 16. 0. 0.

20. 16. 7.295 0.
45. 16. 7.295 0.
3

17. 17. 0. 0.

21. 17. 7.295 0.
45. 17. 7.295 0.
3

18. 18. 0. 0.

22. 18. 7.295 0.
45. 18. 7.295 0.
3

19. 19. 0. 0.

23. 19. 7.295 0.
45. 19. 7.295 0.
3

20. 20. 0. O.

24. 20. 7.295 0.
45. 20. 7.295 0.
3

21. 21. 0. O.

25. 21. 7.295 0.
45. 21. 7.295 0.
3

22. 22. 0. 0.

26. 22. 7.295 0.
45. 22. 7.295 0.
3

23. 23. 0. 0.

27. 23. 7.295 0.
45. 23. 7.295 0.
3

24. 24. 0. 0.

28. 24. 7.295 0.
45. 24. 7.295 0.
3
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25. 25. 0
29. 25. 7
45. 25. 7
3

26. 26. 0
30. 26. 7
45. 26. 7
SURBIS

14

15. 15.
17. 15.4
18.9 15.9
20.8 16.5
22.7 17.3
24.5 18.2
26.2 19.1
27.9 20.2
29.5 21.4
31. 22.7
32.5 24.
33.9 25.5
35.1 27.
35.8 28.
EXECUT

.295 0.
.295 0.
.295 0.
.295 0.

5.5.2 Output Data

Contents of the output-data file for Example Problem 4 is reproduced below in courier typeface, for

distinction.

** STABLPro V4.0**

Upgraded from
FHWA-PCSTABLE

--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices

Run Date:

Time of Run:

Run By:

Input Data Filename:

Output Filename:

PROBLEM DESCRIPTION Example 4 Embankment with reinforcing la
yers

BOUNDARY COORDINATES
3 Top Boundaries
4 Total Boundaries
Boundary X-Left Y-Left X-Right Y-Right Soil Type

No. ft. ft. ft. ft. Below Bnd

1 0.00 15.00 15.00 15.00 2
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2 15.00 15.00
3 28.00 28.00
4 15.00 15.00

ISOTROPIC SOIL PARAMETERS

2 Type(s) of Soil
Soil Total Saturated Cohesion
Type Unit Wt. Unit Wt. Intercept
No. pcf pcft psf
1 19.6 20.4 5.8
2 18.8 19.6 9.6

Searching Routine Will Be Limited To An Area Defined By
Will Deflect Surfaces Upward

Of Which The First 1 Boundaries

28.00 28.00 1
45.00 28.00 1
45.00 15.00 2
Friction Pore Pressure Piez.
Angle Pressure Constant Surface
(deg) Param. psf No.
27.0 0.00 0.0 1
30.0 0.00 0.0 1

1 Boundaries

Boundary X-Left Y-Left X-Right Y-Right
No. ft. ft. ft. ft.
1 0.00 5.00 45.00 5.00
REINFORCING LAYER(S)
12 REINFORCING LAYER(S) SPECIFIED
REINFORCING LAYER NO. 1
3 POINTS DEFINE THIS LAYER
POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 15.00 15.00 0.00 0.000
2 19.00 15.00 7.30 0.000
3 45.00 15.00 7.30 0.000
REINFORCING LAYER NO. 2
3 POINTS DEFINE THIS LAYER
POINT X—-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 16.00 16.00 0.00 0.000
2 20.00 16.00 7.30 0.000
3 45.00 16.00 7.30 0.000
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REINFORCING LAYER NO. 3

3 POINTS DEFINE THIS LAYER

POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 17.00 17.00 0.00 0.000
2 21.00 17.00 7.30 0.000
3 45.00 17.00 7.30 0.000
REINFORCING LAYER NO. 4

3 POINTS DEFINE THIS LAYER

POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 18.00 18.00 0.00 0.000
2 22.00 18.00 7.30 0.000
3 45.00 18.00 7.30 0.000
REINFORCING LAYER NO. 5

3 POINTS DEFINE THIS LAYER

POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 19.00 19.00 0.00 0.000
2 23.00 19.00 7.30 0.000
3 45.00 19.00 7.30 0.000
REINFORCING LAYER NO. 6

3 POINTS DEFINE THIS LAYER

POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 20.00 20.00 0.00 0.000
2 24.00 20.00 7.30 0.000
3 45.00 20.00 7.30 0.000
REINFORCING LAYER NO. 7

3 POINTS DEFINE THIS LAYER

POINT X-COORD Y-COORD FORCE INCLINATION
NO. FACTOR
1 21.00 21.00 0.00 0.000
2 25.00 21.00 7.30 0.000
3 45.00 21.00 7.30 0.000
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REINFORCING LAYER NO.

8

3 POINTS DEFINE THIS LAYER

POINT X-COORD
NO.
1 22.00
2 26.00
3 45.00

REINFORCING LAYER NO.

Y-COORD

22.00
22.00
22.00

9

3 POINTS DEFINE THIS LAYER

POINT X-COORD
NO.
1 23.00
2 27.00
3 45.00

REINFORCING LAYER NO.
3 POINTS DEFINE THIS
POINT X-COORD
NO.
1 24.00
2 28.00
3 45.00

REINFORCING LAYER NO.
3 POINTS DEFINE THIS
POINT X-COORD
NO.
1 25.00
2 29.00
3 45.00

REINFORCING LAYER NO.

3 POINTS DEFINE THIS
POINT X-COORD
NO.
1 26.00

User’s Manual (Rel. October/2015)

Y-COORD

23.00
23.00
23.00

10

LAYER

Y-COORD

24.00

24.00
24.00

11

LAYER

Y-COORD

25.00
25.00
25.00

12

LAYER

Y-COORD

26.00

FORCE INCLINATION
FACTOR
0.00 0.000
7.30 0.000
7.30 0.000
FORCE INCLINATION
FACTOR
0.00 0.000
7.30 0.000
7.30 0.000
FORCE INCLINATION
FACTOR
0.00 0.000
7.30 0.000
7.30 0.000
FORCE INCLINATION
FACTOR
0.00 0.000
7.30 0.000
7.30 0.000
FORCE INCLINATION
FACTOR
0.00 0.000
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2 30.00 26.00 7.30 0.000
3 45.00 26.00 7.30 0.000

Trial Failure Surface Specified By 14 Coordinate Points

Point X-Surf Y-Surf
No. ft. ft.
1 15.00 15.00
2 17.00 15.40
3 18.90 15.90
4 20.80 16.50
5 22.70 17.30
6 24.50 18.20
7 26.20 19.10
8 27.90 20.20
9 29.50 21.40
10 31.00 22.70
11 32.50 24.00
12 33.90 25.50
13 35.10 27.00
14 35.80 28.00
Circle Center At X = 9.5 ; Y = 47.9 and Radius, 33.4
Factor Of Safety For The Preceding Specified Surface = 1.125

5.5.3 Graphical Results of Computer Analysis

The factor of safety for the same specified failure surface without tiebacks is 1.113. The factor of
safety for the specified failure surface increases to 1.629 with the tieback as shown in Figure 5.7.
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% Ensoft Graphics Utility for STABLPro, x=012 y=3011 [E1|
b P Y ¥

Input Data:

Factor of Safety = 1.120

Computed Values:

10 Slip Sui

| Slip Surtace
AllT L

Tiokal Str

Fare

Move View

Left | Right

Do

Figure 5.9 Plot of the block-failure surface with tiebacks of Example Problem 3.
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5.6 Example Problem 5 (Multi-Layer Slope, Sl units)

The fifth example problem demonstrates the use of tiebacks for stabilizing an unstable earth slope.
The slope profile consists of three layers of soft to medium stiff clays overlying a dense sand deposit.
The coordinates of each line for defining the soil profile and surface are shown in Fig. 5.10 and the slope
profile is shown in Fig. 5.11.

The factor of safety against the slope failure based on the Simplified Bishop Method is 1.041as
shown in Fig. 5.12. Two tiebacks are considered to increase the stability of the slope. The location and
parameters of each tieback are shown in Fig. 5.13. The Simplified Bishop method was used for analyzing
the slope with the support of tiebacks. The factor of safety against failure increases from 1.041 to 1.230 as
shown in Fig. 5.14.  All the trial surfaces, which cover extensive area, are also plotted in the same figure
for reference.

Left s [m] |Left' [m] [Right:[m] |Right' [m] |Soil Humber
1 54.9 B34 677 671 1
Z 677 67.1 72 63.2 1
3 72 E3.2 a0 0.7 1
4 a0 7 25 753 1
5 25 5.3 90.5 782 1
E 0.5 8.2 110 8.2 1
7 54.8 £4.9 30.5 65.9 2
a8 30.5 653.9 110 65.9 2
3 54.9 631 30.5 &0 3
10 {905 B0 107 4 3
1 |1m B4 110 63 3
12 |549 57.3 90.5 57.3 4
132|905 57.3 10 E2.5 4
14 |1M B25 110 61.5 4

Figure 5.10 Coordinates of each line of the soil profile and the ground surface of Example
Problem 5.
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M,
14

//)‘-\
, ; S

Figure 5.11 General soil profile of Example Problem 5.

A StablPro Graphics = [= =

Input Data:

Factor of Safety = 1.041, X=78.96, ¥ =93.11
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Figure 5.12 The most critical slope (F.S. = 1.041) of Example Problem 5.
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CHAPTER 5 — Example Problem 8 — 5-40

" L‘. User-Specified Tieback Data = || =] ER
Faint |Boundary |# Coord. | Coord. [Load [kM] |Spacing |Inchnation | Free Length [m)
Surface # | [m) [m] [m] [DEG.)
1 2 o == 337 248 o 60
e 3 o 70 296.4 248 o 60
Add Row Ingert Raw | IW
15 tiebacks maximurm

Figure 5.13 The coordinates and parameters of tiebacks used in Example Problem 5.

fs

R Ensoft Graphics Utility for STABLPro, x=>56.44, y=75833 = || 22
b p ¥ ¥

Factor of Safety =1.230, X =78.96, ¥ =93.14,

Surface P
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Computed Yalues:
stian Informati
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Cloze

Figure 5.14 The most critical slope (F.S. = 1.230) of Example Problem 5 with support
from two tiebacks.
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5.6.1

PROFI

Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 5 is reproduced below in courier
typeface, for distinction.

L

Example #5

14 6

2

54.9 68.4 67.7 67.1 1
67.7 67.1 72. 69.2 1
72. 69.2 80. 70.7 1
80. 70.7 85. 75.3 1
85. 75.3 90.5 78.2 1

90.5 78.2 110. 78.2 1
54.8 64.9 90.5 68.9 2
90.5 68.9 110. 68.9 2
54.9 63.1 90.5 60. 3

90.5 60. 101. 64. 3

101. 64. 110. 63. 3

54.9 57.3 90.5 57.3 4
90.5 57.3 101. 62.5 4
101. 62.5 110. 61.5 4
SOIL

4

19.6 19.6 47.9 0. 0. 0. 1
17.3 17.3 23.9 0. 0. 0. 1
17.3 17.3 36.3 0. 0. 0. 1
19.6 19.6 0. 35. 0. 0. 1
WATER

1 9.8

3

55. 67.1

63. 67.1

110. 70.

TIES

2

2 0. 68. 337. 2.8 0. 60.
3 0. 70. 296.4 2.8 0. 60.
CIRCL2

10 10

55. 65. 90. 105.

50. 5. 0. -25.

EXECUT

5.6.2 Output Data

Contents of the output-data file for Example Problem 5 is reproduced below in courier typeface, for
distinction.

** STABLPro V4.0**
Upgraded from
FHWA-PCSTABLE

--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices

Run Date:
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CHAPTER 5 — Example Problem 8 — 5-42

Run Date:

Time of Run:

Run By:

Input Data Filename:
Output Filename:

Plotted Output Filename:

X-Right

M

67.
.00
80.
85.
90.
110.
90.
110.
90.
101.

72

110.

90.
101.
110.

70

00
00
50
00
50
00
50
00
00
50
00
00

Angle
(deg)

o O O o

O O O o

PROBLEM DESCRIPTION Example #5
BOUNDARY COORDINATES
6 Top Boundaries
14 Total Boundaries
Boundary X-Left Y-Left
No. M M
1 54.90 68.40
2 67.70 67.10
3 72.00 69.20
4 80.00 70.70
5 85.00 75.30
6 90.50 78.20
7 54.80 64.90
8 90.50 68.90
9 54.90 63.10
10 90.50 60.00
11 101.00 64.00
12 54.90 57.30
13 90.50 57.30
14 101.00 62.50
1
ISOTROPIC SOIL PARAMETERS
4 Type(s) of Soil
Soil Total Saturated Cohesion Friction
Type Unit Wt. Unit Wt. Intercept
No. kN/M"3 kN/M"3 kPa
1 19.6 19.6 47.9
2 17.3 17.3 23.9
3 17.3 17.3 36.3
4 19.6 19.6 0.0
1

1 PIEZOMETRIC SURFACE (S)

User’s Manual (Rel. October/2015)
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Y-Right Soil Type
M Below Bnd
67.10 1
69.20 1
70.70 1
75.30 1
78.20 1
78.20 1
68.90 2
68.90 2
60.00 3
64.00 3
63.00 3
57.30 4
62.50 4
61.50 4
Pore Pressure Piez.
Pressure Constant Surface
Param. kPa No.
0.00 0.0 1
0.00 0.0 1
0.00 0.0 1
0.00 0.0 1

HAVE BEEN SPECIFIED
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CHAPTER 5 — Example Problem 8 — 5-43

Unit Weight

Piezometric

of Water

Surface No.

9.80 kN/M"3

1 Specified by

3 Coordinate Points

Point X-Water Y-Water
No. M M
1 55.00 67.10
2 63.00 67.10
3 110.00 70.00
1
TIEBACK LOAD (S)
2 Tieback Load(s) Specified
Tieback X-Pos Y-Pos Load Spacing Inclination Length
No. M M KN M (deqg) M
1 69.54 68.00 337.0 2.8 0.00 60.0
2 76.27 70.00 296.4 2.8 0.00 60.0
NOTE - An Equivalent Line Load Is Calculated For Each Row Of Tiebacks
Assuming A Uniform Distribution Of Load Horizontally Between
Individual Tiebacks.
1

A Critical Failure Surface Searching Method, Using A Random
Technique For Generating Circular Surfaces, Has Been Specified.

100 Trial Surfaces Have Been Generated.

10 Surfaces Initiate From Each Of 10 Points Equally Spaced

Along The Ground Surface Between X = 55.00 M
and X = 65.00 M
Each Surface Terminates Between X = 90.00 M
and X = 105.00 M

Unless Further Limitations Were Imposed, The Minimum Elevation

At Which A Surface Extends Is Y 50.00 M

5.00 M Line Segments Define Each Trial Failure Surface.

Restrictions Have Been Imposed Upon The Angle Of Initiation.
The Angle Has Been Restricted Between The Angles Of -25.0
And 0.0 deg.
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CHAPTER 5 — Example Problem 8 — 5-44

1
Following Are Displayed The Ten Most Critical Of The Trial
Failure Surfaces Examined. They Are Ordered - Most Critical
First.
* * Safety Factors Are Calculated By The Modified Bishop Method * *
Failure Surface Specified By 10 Coordinate Points
Point X-Surf Y-Surf
No. M M
1 65.00 67.37
2 69.58 65.37
3 74.44 64.18
4 79.43 63.83
5 84.40 64.34
6 89.22 65.68
7 93.73 67.83
8 97.82 70.71
9 101.36 74.24
10 104.15 78.20
Circle Center At X = 79.0 ; Y = 93.1 and Radius, 29.3
* k% l . 230 * k%
Individual data on the 20 slices
Water Water Tie Tie Earthquake
Force Force Force Force Force Surcharge
Slice Width Weight Top Bot Norm Tan Hor Ver Load
No. Ft (m) Lbs (kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs (kg) Lbs (kg)
1 0.3 0.30E+00 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
2 2.1 0.19E+02 0.15E+01 0.12E+02 0.00E+00 0.0 0.0 0.0 0.0
3 0.3 0.46E+01 0.72E+00 0.33E+01 0.00E+00 0.0 0.0 0.0 0.0
4 1.9 0.63E+02 0.00E+00 0.33E+02 0.00E+00 0.0 0.0 0.0 0.0
5 2.4 0.16E+03 0.00E+00 0.61E+02 0.10E+02 10.2 0.0 0.0 0.0
6 2.4 0.22E+03 0.00E+00 0.80E+02 0.17E+02 17.1 0.0 0.0 0.0
7 5.0 0.56E+03 0.00E+00 0.19E+03 0.28E+02 27.6 0.0 0.0 0.0
8 0.6 0.71E+02 0.00E+00 0.24E+02 0.36E+01 3.6 0.0 0.0 0.0
9 4.4 0.70E+03 0.00E+00 0.18E+03 0.34E+02 34.1 0.0 0.0 0.0
10 0.6 0.12E+03 0.00E+00 0.24E+02 0.44E+01 4.4 0.0 0.0 0.0
11 3.5 0.73E+03 0.00E+00 0.13E+03 0.26E+02 25.7 0.0 0.0 0.0
12 0.8 0.17E+03 0.00E+00 0.24E+02 0.55E+01 5.5 0.0 0.0 0.0
13 1.3 0.29E+03 0.00E+00 0.39E+02 0.86E+01 8.6 0.0 0.0 0.0
14 1.7 0.37E+03 0.00E+00 0.39E+02 0.11E+02 11.0 0.0 0.0 0.0
15 1.6 0.32E+03 0.00E+00 0.25E+02 0.99E+01 9.9 0.0 0.0 0.0
16 1.5 0.29E+03 0.00E+00 0.12E+02 0.92E+01 9.2 0.0 0.0 0.0
17 0.3 0.53E+02 0.00E+00 0.34E+00 0.18E+01 1.8 0.0 0.0 0.0
18 2.3 0.37E+03 0.00E+00 0.00E+00 0.13E+02 13.1 0.0 0.0 0.0
19 3.5 0.40E+03 0.00E+00 0.00E+00 0.20E+02 19.6 0.0 0.0 0.0
20 2.8 0.11E+03 0.00E+00 0.00E+00 0.12E+02 12.1 0.0 0.0 0.0
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CHAPTER 5 - Example Problem 8 — 5-45

Failure Surface Specified By 11 Coordinate Points

Point X-Surf Y-Surf
No.

1 62.78 67.60

2 67.34 65.56

3 72.17 64.27

4 77.15 63.76

5 82.14 64.06

6 87.02 65.14

7 91.67 66.99

8 95.96 69.55

9 99.79 72.76

10 103.06 76.55

11 104.08 78.20

Circle Center At X 77.8 Y

1.277

* K Kk

Failure Surface Specified By 11

Point X-Surf Y-Surf
No

1 62.78 67.60

2 67.33 65.53

3 72.16 64.25

4 77.14 63.82

5 82.13 64.25

6 86.96 65.51

7 91.52 67.58

8 95.65 70.39

9 99.25 73.86

10 102.20 77.90

11 102.35 78.20

Circle Center At X 77.2 Y

1.304 bk

Failure Surface Specified By 11

Point X-Surf Y-Surf
No
1 63.89 67.49
2 68.53 65.62
3 73.40 64.51
4 78.39 64.19

= 95.1 and Radius, 31.3

Coordinate Points

= 93.1 and Radius, 29.3

Coordinate Points
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= O W o Jo Ul

=

83.
88.
92.
96.
100.
103.
104.

Circle Center At

37
21
79
99
71
85
03

1.320

* k%

64.
65.
67.
70.
73.
77.
78.

67
92
93
65
99
88
20

Failure Surface Specified By 12

Point

O ~J oy Ul WwWDN

Ne]

10
11
12

X-Surf

59.
63.
68.
73.
78.
83.
88.
93.
97.
101.
104.
104.

Circle Center At

44
99
78
73
73
68
48
03
24
02
30
67

1.355

* % %

67.
65.
64.
63.
63.
64.
65.
67.
70.
73.
77.
78.

Y-Surf

94
85
43
71
70
40
81
88
57
85
62
20

Failure Surface Specified By 12

= 95.6 and Radius, 31.4

Coordinate Points

= 98.6 and Radius, 35.0

Coordinate Points

Point X-Surf Y-Surf
No. M

1 59.44 67.94

2 63.98 65.83

3 68.77 64.40

4 73.72 63.69

5 78.72 63.72

6 83.66 64.48

7 88.44 65.96

8 92.95 68.12

9 97.09 70.92

10 100.77 74.30

11 103.92 78.19

12 103.93 78.20

Circle Center At X = 76.0 ; Y

User’s Manual (Rel. October/2015)
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1.360

* k%

= 95.0 and Radius, 31.3

Coordinate Points

= 100.0 and Radius, 36.3

1
Failure Surface Specified By 11 Coordinate Points
Point X-Surf Y-Surf
No.
1 60.56 67.83
2 65.09 65.72
3 69.90 64.37
4 74.87 63.80
5 79.87 64.03
6 84.76 65.05
7 89.43 66.84
8 93.75 69.35
9 97.62 72.52
10 100.93 76.27
11 102.15 78.20
Circle Center At X 75.9 Y
1.372 x Kk
Failure Surface Specified By 12
Point X-Surf Y-Surf
No.
1 58.33 68.05
2 62.89 65.99
3 67.68 64.57
4 72.63 63.82
5 77.62 63.75
6 82.59 64.38
7 87.41 65.68
8 92.02 67.63
9 96.31 70.19
10 100.21 73.32
11 103.65 76.95
12 104.54 78.20
Circle Center At X = 75.6 Y
* % % 1.413 * % %
1

Failure Surface Specified By 10

Point X-Surf
No. M

User’s Manual (Rel. October/2015)
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1 62.78 67.60
2 67.41 65.72
3 72.30 64.66
4 77.29 64.46
5 82.25 65.12
6 87.02 66.63
7 91.45 68.93
8 95.43 71.97
9 98.82 75.64
10 100.47 78.20
Circle Center At X = 75.9 ; Y = 93.4 and Radius, 28.9
* k% 1-430 * k%

Failure Surface Specified By 10 Coordinate Points

Point X-Surf Y-Surf
No. M M

1 62.78 67.60

2 67.36 65.61

3 72.24 64.50

4 77.24 64.32

5 82.18 65.06

6 86.90 66.71

7 91.23 69.20

8 95.03 72.46

9 98.16 76.36

10 99.13 78.20

Circle Center At X = 75.7 ; Y = 91.1 and Radius, 26.9
* % % 1 . 440 * % %
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CHAPTER 5 — Example Problem 8 — 5-49

5.7 Example Problem 6 (Complicated Slope Geometry)

The six example problem demonstrates an application with complicated soil conditions (8 soil
layers) and geometry (24 sectional lines on a bluff) which can be handled by STABLPRO. The layer of
each sectional line for defining the soil profile and surface are shown in Fig. 5.15 and the soil-layer
numbers is shown in Fig. 5.16. A area with graben debris was defined by Lines 16, 17, 19 and 20.

The factor of safety against the slope failure based on the Simplified Bishop Method is 1.305 as
shown in Fig. 5.17.

—a
I
g
3 15 s
10
1?? 18 .
/ 20

Figure 5.15 Layout of sectional lines of Example Problem 6.
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: r :
//J-E-‘f 5 =
5
b -
g 2 a

Figure 5.16 Layout of soil layer numbers of Example Problem 6.
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A Ensoft Graphics Utility for STABLPro, x = 2.67, y = 11045 (===

Input Data:

actor of Safety = 1.305, X =272.25, ¥ =554.39, R=551.30

_<N B<0 W <]

Move View

| Up |
Left | Right
Drown

Figure 5.17 The most critical slope (F.S. = 1.041) of Example Problem 6.

5.7.1 Input Data for Computer Analysis

The contents of the input-data file prepared for Example Problem 6 is reproduced below in courier
typeface, for distinction.

PROFIL

Example 6

24 14 2

54. 0. 120. 46. 1

120. 46. 272. 174. 1
272. 174. 295. 194. 2
295. 194. 306. 202.6 3
306. 202.6 307. 203. 4
307. 203. 310. 208.5 5
310. 208.5 311. 210. 5

311. 210. 400. 252. 6
400. 252. 429. 254. 6
429. 254. 431. 272. 7
431. 272. 432. 284. 8
432. 284. 460. 284. 8
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460. 284. 596. 294.
596. 294. 660. 297.
431. 272. 660. 272.
311. 210. 400. 252.
400. 252. 429. 254.
429. 254. 660. 252.
311. 210. 426. 222.
426. 222. 429. 254.
307. 203. 660. 228.

N O OOl oy O 1 O o

306. 202.6 660. 227.5 3
295. 194. 660. 194.
272. 174. 660. 174.
SOIL

8

21.206809 21. 380. 25. 0. 0. 1
20.421372 20.5 72. 28. 0. 0. 1
19.635935 19.6 55. 30. 0. 0. 1
17.279623 18.2 0. 20. 0. 0. 1
18.850497 19.6 48. 25. 0. 0. 1
18.850497 21. 10. 25. 0. 0. 1
18.850497 18.9 47.880263 0. 0. 0. 1
18.850497 18.9 71.820395 0. 0. 0. 1
WATER

1 9.8

2

54. 0.

660. 73.152

LIMITS

11

0. 0. 0. 0.

CIRCL2

20 5

64. 260. 300. 480.

0. 15. 0. 0.

EXECUT

5.7.2 Output Data

Contents of the output-data file for Example Problem 6 is reproduced below in courier typeface, for
distinction.

** STABLPro V4.0**

Upgraded from
FHWA-PCSTABLE

--Slope Stability Analysis--
Simplified Janbu, Simplified Bishop
or Spencer s Method of Slices

Run Date:

Time of Run:

Run By:

Input Data Filename:
Output Filename:

Plotted Output Filename:
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X-Right

120.
.00
295.
306.
307.
310.
311.
400.
429.
431.
432.
460.
596.
660.
660.
400.

272

429.
660.
426.
429.
660.
660.
660.
660.

00

00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00

Angle
(deg)

25.
28.
30.
20.
25.
25.

0.

0.

[eNoNeoNoNeoNoNoNe]

PROBLEM DESCRIPTION Example 6
BOUNDARY COORDINATES
14 Top Boundaries
24 Total Boundaries
Boundary X-Left Y-Left
No. M M
1 54.00 0.00
2 120.00 46.00
3 272.00 174.00
4 295.00 194.00
5 306.00 202.60
6 307.00 203.00
7 310.00 208.50
8 311.00 210.00
9 400.00 252.00
10 429.00 254.00
11 431.00 272.00
12 432.00 284.00
13 460.00 284.00
14 596.00 294.00
15 431.00 272.00
16 311.00 210.00
17 400.00 252.00
18 429.00 254.00
19 311.00 210.00
20 426.00 222.00
21 307.00 203.00
22 306.00 202.60
23 295.00 194.00
24 272.00 174.00
1
ISOTROPIC SOIL PARAMETERS
8 Type(s) of Soil
Soil Total Saturated Cohesion Friction
Type Unit Wt. Unit Wt. Intercept
No. kN/M"3 kN/M"3 kPa
1 21.2 21.0 380.0
2 20.4 20.5 72.0
3 19.6 19.6 55.0
4 17.3 18.2 0.0
5 18.9 19.6 48.0
6 18.9 21.0 10.0
7 18.9 18.9 47.9
8 18.9 18.9 71.8
1

User’s Manual (Rel. October/2015)
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Y-Right

46.
.00
194.
202.
203.
208.
210.
252.
254.
272.
284.
284.
294.
297.
272.
252.
254.
252.
222.
254.
228.
227.
194.
174.

174

Pore

.00
.00
.00
.00
.00
.00
.00
.00
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00

00
60
00
50
00
00
00
00
00
00
00
00
00
00
00
00
00
00
00
50
00
00

Soil Type
Below Bnd

EF N WD OOty 100 0OWOo Joyoy Ul ul s W - -

Pressure Piez.
Pressure Constant Surface
Param.

kPa No.

[eNeNeNoNoNeoNoNal
[eNeNeNoNoNeoNoNal
el el
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1 PIEZOMETRIC SURFACE (S) HAVE BEEN SPECIFIED

Unit Weight of Water = 9.80 kN/M"3
Piezometric Surface No. 1 Specified by 2 Coordinate Points
Point X-Water Y-Water
No. M M
1 54.00 0.00
2 660.00 73.15
1
Searching Routine Will Be Limited To An Area Defined By 1 Boundaries
Of Which The First 1 Boundaries Will Deflect Surfaces Upward
Boundary X-Left Y-Left X-Right Y-Right
No. M M M M
1 0.00 0.00 0.00 0.00
1
A Critical Failure Surface Searching Method, Using A Random
Technique For Generating Circular Surfaces, Has Been Specified.
100 Trial Surfaces Have Been Generated.
5 Surfaces Initiate From Each Of 20 Points Equally Spaced
Along The Ground Surface Between X = 64.00 M
and X = 260.00 M
Each Surface Terminates Between X = 300.00 M
and X = 480.00 M
Unless Further Limitations Were Imposed, The Minimum Elevation
At Which A Surface Extends Is Y = 0.00 M
15.00 M Line Segments Define Each Trial Failure Surface.
1
Following Are Displayed The Ten Most Critical Of The Trial
Failure Surfaces Examined. They Are Ordered - Most Critical
First.
* * Safety Factors Are Calculated By The Modified Bishop Method * *
Failure Surface Specified By 36 Coordinate Points
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Point X-Surf Y-Surf
No. M M

1 64.00 6.97

2 78.87 8.95

3 93.68 11.33

4 108.42 14.11

5 123.08 17.30

6 137.64 20.88

7 152.11 24.86

8 166.46 29.23

9 180.68 33.98

10 194.77 39.13

11 208.72 44.65

12 222.51 50.55

13 236.13 56.83

14 249.58 63.47

15 262.85 70.47

16 275.91 77.84

17 288.78 85.56

18 301.42 93.62

19 313.85 102.03

20 326.04 110.77

21 337.99 119.84

22 349.68 129.23

23 361.12 138.93

24 372.29 148.94

25 383.18 159.26

26 393.79 169.86

27 404.10 180.75

28 414.12 191.92

29 423.83 203.35

30 433.22 215.05

31 442.29 227.00

32 451.03 239.18

33 459.44 251.61

34 467.51 264.25

35 475.23 277.11

36 479.94 285.47

Circle Center At X = -1.3 ; Y = 554.4 and Radius, 551.3
* % % 1 . 305 * % %
Individual data on the 54 slices
Water Water Tie Tie Earthquake
Force Force Force Force Force Surcharge
Slice Width Weight Top Bot Norm Tan Hor Ver Load
No. Ft (m) Lbs (kg) Lbs (kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs(kg) Lbs(kg)
1 14.9 0.13E+04 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
2 14.8 0.39E+04 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
3 14.7 0.63E+04 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
4 11.6 0.65E+04 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
5 3.1 0.20E+04 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
6 14.6 0.11E+05 0.00E+00 0.00E+00 0.00E+00 0.0 0.0 0.0 0.0
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7 14.5 0.14E+05
8 14.3 0.16E+05
9 14.2 0.18E+05
10 14.1 0.20E+05
11 13.9 0.22E+05
12 13.8 0.23E+05
13 13.6 0.24E+05
14 13.4 0.25E+05
15 13.3 0.26E+05
16 9.2 0.19E+05
17 3.9 0.82E+04
18 12.9 0.28E+05
19 6.2 0.14E+05
20 6.4 0.14E+05
21 4.6 0.10E+05
22 1.0 0.22E+04
23 3.0 0.67E+04
24 1.0 0.23E+04
25 2.8 0.65E+04
26 12.2 0.27E+05
27 11.9 0.26E+05
28 11.7 0.24E+05
29 11.4 0.22E+05
30 11.2 0.21E+05
31 10.9 0.19E+05
32 10.6 0.17E+05
33 3.9 0.60E+04
34 2.3 0.34E+04
35 4.1 0.58E+04
36 10.0 0.13E+05
37 1.8 0.20E+04
38 7.9 0.83E+04
39 2.2 0.20E+04
40 3.0 0.26E+04
41 1.2 0.11E+04
42 0.3 0.34E+03
43 0.4 0.47E+03
44 1.0 0.12E+04
45 1.2 0.16E+04
46 9.1 0.11E405
47 8.7 0.84E+04
48 8.4 0.61E+04
49 0.6 0.34E+03
50 0.8 0.46E+03
51 6.7 0.32E+04
52 4.7 0.15E+04
53 3.1 0.60E+03
54 4.7 0.36E+03

leNeoNeoloNeoNeoNoNoNoNeololNeoNoNoNeoloNoNoNoNoloNeoNoNoNoNoNoNoNo oo Neo o NoNoNoNo oo o NeoNoNoNeoNoNeo o No]

.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

lcNoNeoNeoNeoNoNoloNeoloNolololNoNoNoNoNolNoNoNoNolo o NHoNoBo oo NoNo oo NoNoNoBoNoNeoNoNoloNoNoNoNo o Ne]

lcNeoNeoNeoNeoNoNoloNoloNolololNoNoNoNolNolNoNoNoNolo o NoNoNo oo NoNo oo NoNoNoBoNoNeoNoNoBoNoNoNoNo o Ne]

.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00
.00E+00

Failure Surface Specified By 34 Coordinate Points

Point
No.

~N o U WN

X-Surf
M

84.63

99.44
114.18
128.83
143.39
157.85
172.18

Y-Surf

21.
23.
26.
29.
33.
37.
41.

User’s Manual (Rel. October/2015)
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35
74
53
74
35
36
77
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CHAPTER 5 — Example Problem 8 — 5-57

8

9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

186.
200.
214.
228.
241.
255.
268.
281.
294.
306.
319.
331.
343.
354.
366.
377.
387.
398.
408.
418.
427.
437.
446.
454,
462.
470.
473.

Circle Center At

* K Kk l.

39
46
38
15
74
15
37
38
19
77
12
24
10
70
04
10
87
35
53
41
96
19
09
65
87
73
93

330

46.
51.
57.
63.
69.
76.
83.
90.
98.
106.
115.
124.
133.
142.
152.
162.
173.
184.
195.
206.
217.
229.
.85
254.
266.
279.
285.

241

* K Kk

57
77
35
32
67
39
48
93
75
91
42
27
45
95
77
91
34
07
09
39
95
77

17
72
49
02

Failure Surface Specified By 33

Point X-Surf
No. M
1 94.95
2 109.83
3 124.64
4 139.38
5 154.02
6 168.56
7 182.98
8 197.28
9 211.43
10 225.42
11 239.24
12 252.89
13 266.34
14 279.58
15 292.60
16 305.40
17 317.95
18 330.25
19 342.29
20 354.05
21 365.53

Y-Surf

28.
30.
32.
35.
38.
.54
46.
51.
56.
61.
67.
73.
80.
87.
94.
102.
110.
119.
128.
137.
147.

42
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54
45
81
61
85

66
21
19
59
41
65
29
33
77
60
81
40
35
65
31

= 556.9 and Radius,

Coordinate Points
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CHAPTER 5 — Example Problem 8 — 5-58

22 376.71 157.31
23 387.59 167.64
24 398.15 178.30
25 408.38 189.26
26 418.28 200.53
27 427.83 212.10
28 437.04 223.94
29 445,88 236.06
30 454,35 248.43
31 462.45 261.06
32 470.17 273.92
33 476.48 285.21
Circle Center At X = 38.9 ; Y = 523.8 and Radius, 498.4
* K x 1'336 * K x

Failure Surface Specified By 34 Coordinate Points

Point X-Surf Y-Surf
No M M
1 94.95 28.54
2 109.95 28.49
3 124.94 28.99
4 139.90 30.06
5 154.81 31.68
6 169.66 33.85
7 184.41 36.58
8 199.04 39.85
9 213.55 43.66
10 227.91 48.02
11 242.09 52.90
12 256.08 58.31
13 269.86 64.24
14 283.41 70.67
15 296.71 77.60
16 309.74 85.03
17 322.49 92.94
18 334.94 101.31
19 347.06 110.14
20 358.85 119.42
21 370.28 129.13
22 381.34 139.26
23 392.02 149.79
24 402.30 160.71
25 412.17 172.01
26 421.61 183.67
27 430.61 195.67
28 439.15 208.00
29 447.23 220.64
30 454,83 233.57
31 461.95 246.77
32 468.57 260.23
33 474.69 273.93
34 479.31 285.42
Circle Center At X = 103.9 ; Y = 431.3 and Radius, 402.8
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CHAPTER 5 — Example Problem 8 — 5-59

HxK 1.356

* k%

Failure Surface Specified By 37 Coordinate Points

Point

No.

1 64.
2 78.
3 93.
4 108.
5 123.
6 138.
7 153.
8 168.
9 183.
10 197.
11 212.
12 226.
13 240.
14 254.
15 268.
16 281.
17 294.
18 307.
19 319.
20 331.
21 343.
22 354.
23 365.
24 376.
25 386.
26 395.
27 404.
28 413.
29 421.
30 428.
31 435.
32 442 .
33 448.
34 453.
35 458.
36 462.
37 464.

Circle Center At

X-Surf

00
93
91
90
90
87
78
62
35
96
42
70
78
64
25
60
66
40
82
88
56
85
74
19
19
73
79
36
41
95
95
40
30
63
38
55
25

X

*xK 1.357

Y-Surf

~ O D U1 o)

12.
15.
19.
24.
29.
35.
41.
48.
55.
63.
72.
81.
90.
100.
110.
121.
132.
144.
156.
168.
181.
194.
207.
220.
234.
248.
262.

277

284.

107.0

* % %

.97
.52
.68
.45
.83
.83
.43
.64
45
86
86
45
61
35
64
49
87
78
20
12
53
40
73
49
66
24
19
51
16
13
40
94
73
75
98
.39
31

;Y

Failure Surface Specified By 32

Point
No.

X-Surf

Y-Surf

User’s Manual (Rel. October/2015)
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O Jo U wN

Ne]

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32

105.
120.
135.
149.
l64.
179.
193.
207.
221.
235.
249.
263.
276.
289.
302.
314.
326.
338.
349.
360.
371.
382.
392.
401.
410.
419.
427.
435.

442

449,
456.
456.

Circle Center At

* % % 1

26
20
07
86
56
13
58
87
98
91
63
12
37
37
08
51
62
42
87
97
70
06
02
57
70
40
67
47
.82
70
09
81

365

35.
37.
39.
.59
44,
48.
52.
56.
61.
67.
73.
80.
87.
94.
102.
110.
119.
129.
138.
148.
159.
170.
181.
192.
204.
217.
229.
242.
255.
268.
282.
284.

41

* % %

73
15
10

60
13
18
74
81
39
45
00
03
53
48
89
73
00
69
77
25
11
32
89
79
01
53
33
41
74
31
00

Failure Surface Specified By 34

Point X-S
No
1 74
2 88
3 102.
4 117.
5 131.
6 145.
7 159.
8 173.
9 186.
10 200.
11 213.
12 227
13 240.
14 253.
15 266.
16 278.

urf
M

.32
.70
99
20
32
34
25
05
74
31
76
.08
27
32
22
98

Y-Surf

14
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.16
18.
22.
27.
32.
38.
43.
49.
55.
62.
68.
75.
82.
90.
97.

105.

42
96
77
84
19
79
66
79
18
83
72
87
27
91
80

= 454.6 and Radius,

Coordinate Points
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17 291.59 113.93
18 304.04 122.29
19 316.33 130.89
20 328.46 139.73
21 340.41 148.78
22 352.19 158.07
23 363.80 167.57
24 375.22 177.30
25 386.45 187.24
26 397.50 197.39
27 408.35 207.74
28 419.00 218.31
29 429.45 229.07
30 439.69 240.02
31 449,73 251.17
32 459.55 262.51
33 469.15 274.03
34 478.22 285.34
Circle Center At X = -143.5 ; Y = 775.0 and Radius, 791.4
* k% 1'368 * k%

Failure Surface Specified By 34 Coordinate Points

Point X-Surf Y-Surf
No. M M
1 84.63 21.35
2 99.03 25.57
3 113.34 30.06
4 127.55 34.85
5 141.67 39.91
6 155.69 45.25
7 169.60 50.86
8 183.40 56.75
9 197.07 62.91
10 210.62 69.34
11 224.05 76.04
12 237.33 83.00
13 250.48 90.22
14 263.48 97.70
15 276.33 105.44
16 289.03 113.43
17 301.57 121.66
18 313.94 130.15
19 326.14 138.88
20 338.16 147.84
21 350.01 157.04
22 361.67 166.48
23 373.14 176.14
24 384.42 186.03
25 395.50 196.14
26 406.38 206.46
27 417.06 217.00
28 427.52 227.75
29 437.77 238.70
30 447.80 249.86
31 457.61 261.21
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32 467.19 272.75
33 476.54 284.48
34 477.14 285.26
Circle Center At X = -121.4 ; Y = 751.7 and Radius, 758.9
* K x 1'373 * K x

1
Failure Surface Specified By 29 Coordinate Points
Point X-Surf Y-Surf
No. M M
1 136.21 59.65
2 151.09 61.52
3 165.90 63.91
4 180.62 66.81
5 195.23 70.22
6 209.71 74.14
7 224.04 78.55
8 238.22 83.46
9 252.21 88.86
10 266.01 94.74
11 279.60 101.10
12 292.96 107.92
13 306.07 115.20
14 318.92 122.94
15 331.50 131.11
16 343.78 139.72
17 355.76 148.74
18 367.42 158.18
19 378.75 168.02
20 389.73 178.24
21 400.34 188.84
22 410.58 199.80
23 420.44 211.10
24 429.89 222.75
25 438.94 234.71
26 447.57 246.98
27 455.76 259.55
28 463.52 272.39
29 470.42 284.77
Circle Center At X = 89.7 ; Y = 489.4 and Radius, 432.3
* Kk Kk 1 . 400 * Kk Kk
Failure Surface Specified By 32 Coordinate Points
Point X-Surf Y-Surf
No. M M
1 64.00 6.97
2 78.89 5.17
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3 93.86 4.14
4 108.85 3.88
5 123.85 4.38
6 138.79 5.65
7 153.65 7.69
8 168.39 10.48
9 182.97 14.02

10 197.34 18.31
11 211.48 23.32
12 225.34 29.05
13 238.89 35.49
14 252.09 42.61
15 264.91 50.39
16 277.32 58.83
17 289.28 67.88
18 300.76 77.54
19 311.73 87.77
20 322.16 98.55
21 332.02 109.85
22 341.30 121.64
23 349.95 133.89
24 357.97 146.56
25 365.33 159.63
26 372.02 173.06
27 378.00 186.82
28 383.28 200.86
29 387.82 215.15
30 391.63 229.66
31 394.70 244 .34
32 395.56 249.91
Circle Center At X = 106.5 ; Y = 296.8 and Radius, 292.9
* % % 1.411 * % %
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List of Technical References — R-2

R.1 Error Messages

STABLPRO is intended to be error free, assuming that the input data are correctly prepared. To avoid
problems when the data have been incorrectly prepared. STABLPRO checks all data, as they are being
read in, for consistency with program requirements.

If an inconsistency is found in data submitted, STABLPRO points it out by displaying an error indication.
Unless the error is of a nature that demands immediate termination of execution. STABLPRO continues
reading data and checking for more errors until a point is reached in execution where termination is
required as a consequence of previously determined errors.

The errors are coded and referenced to descriptions in the next section. Each input error has a two digit
number prefixed with two letters, associated the error with a particular command or class of errors. The
prefixes are listed below.

SQ Command Sequence errors
FR Free-form Reader errors
PF errors associated with command PROFIL

WA errors associated with command WATER

SF errors associated with command SURFAC

LM errors associated with command LIMITS

LD errors associated with command LOADS
SL errors associated with command SOIL
Al errors associated with command ANISO

RC errors associated with commands RANDOM and CIRCLE

BK errors associated with command BLOCK
Tl errors associated with command TIES
SP errors associated with command SPENCR
User’s Manual (Rel. October/2015) STABLPRO for Windows
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List of Technical References — R-3

R.2 Command Sequence Errors
5Qo1

A command other than PROFIL has been used as the first command in the execution sequence.
The first command must be PROFIL. PROFIL initialized STABLPRO prior to reading all data pertinent to
the definition of a problem. All data that would have been read prior to encountering the first use of
command PROFIL would have been nullified and would not have been made available to STABLPRO for
the purpose of analyzing the first problem.

5Q02

An attempt to compute the factor of safety of a specified trial failure surface with command
EXECUT has been aborted. The isotropic soil parameters describing the soil types of the current
problem do not exist. After each use of the command PROFIL in an execution sequence, the isotropic
soil parameters of each soil type must be specified by use of command SOIL before command EXECJUT
may be used. Each time a new problem is introduced in an execution sequence by command PROFiIL,
the soil parameters describing soil types of preceding problems are no longer available for use.

5Q03

An attempt to compute the factor of safety of an unspecified trial failure surface e with
command EXECUT has been aborted. After each use of command PROFIL, CIRCLE, RANDOM or BLOCK, a
trial failure surface must be specified with command SURFACE before command EXECUT may be used.

5Q04

The command ANISO has been used without the isotropic soil parameters being defined.
Anisotropic strength data may not be specified unless the isotropic parameters have been define by
command SOIL after the last use of command PROFIL.

5Q05

An attempt to use one of the commands, RANDOM, CIRCLE, or BLOCK has been aborted. The
isotropic soil parameters describing the soil types of the current problem do not exist. After each use of
command PROFIL in an execution sequence, the isotropic soil parameters of each soil type must be
specified by use of command SOIL before any of the above mentioned commands may be used. Each
time a new problem is introduced in an execution sequence by command PROFIL, the soil parameters
describing soil types of preceding problems are no longer available for use.
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R.3 Free-form Reader Error Codes
FRO1

Data are insufficient to continue execution. An attempt was made to read beyond the last data
item specified. Check for missing data items or for gaps between data items on each line larger than
one blank space. This error only occurs at the end of an execution sequence within the data provided
with the last command used.

FROZ2

The line of data displayed begins with one or more blank spaces or may be entirely blank. The
first item of data of each line is required to being in the first column. Lines entirely blank are not
permitted.

FRO3

Within the line of data displayed, a decimal point has been detected for a number read as an
integer. K An integer in not allowed to contain a decimal point. First check if any numbers intended to
be inters contain a decimal point. If not, check if error is indirectly caused by a displacement of data
read. Causes of displacements are discussed below.

FRO4

Within the line of data displayed, a minus sign has been detected for a number read as an
integer. All integers are required to be positive. Negative integers are never required as input for
STABLPRO. This error may be caused indirectly by displacement of data read. Caused of displacements
are discussed below.

Displacements of data read are caused either by inadvertently omitting items of data or by
leaving gaps between items of data larger than one blank space. Data items following a gap larger than
one blank space are not read. Instead, data from the next line are read in their place, producing a
displacement of data read from that point on.

At some point following the displacement, an error will be produced indirectly. A real number
might be read as an integer, or vice versa, producing error FRO3 or FRO6 respectively. A negative real
number read as an integer will also produce error FRO4. When a displacement occurs, and if none of the
above errors are produced, the numeric data will be exhausted and finally a command worked will be
read as numeric data producing error FRO5 or FRO7 depending upon whether an integer or real number
was being read.

If cause of displacement is not found in the displayed line of data, check the preceding lines of
data.
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R.4 PROFIL Error Codes
PFO1

The number of ground surface boundaries exceeds the total number of profile boundaries. The
number of profile boundaries must be less than or equal to the total number of profile boundaries.

PFO2

The number of profile boundaries specified may not exceed 100. The problem must be either
redefined so fewer profile boundaries are used, or the dimensioning of the program must be increased
to accommodate the problem so defined.

PFO3

A negative coordinate has been specified for the profile boundary indicated. All problem
geometry must be located within the 15t quadrant.

PFO4

The coordinates of the end points of the profile boundary indicated have not been specified in
the required order. The coordinates of the left end point must precede those of the right.

PFO5

The ground surface boundaries indicated are not properly ordered or are not continuously
connected. The ground surface boundaries must be specified from left to right and the ground surface
described must be continuous.

PFO6

The required subsurface boundary order is unsatisfied for the boundaries indicated. Of
boundaries which overlap horizontally, those above the other must be specified first.

R.5 WATER Error Codes
WAO01

An attempt has been made to suppress or reactivate undefined water surface data. Data must
be defined by a prior use of command WATER before they can be suppressed. Suppressed data can not
be reactivated if command PROFIL has been used in the execution sequence subsequent to their
suppression. Command PROFIL nullifies all data prior to their use whether the data are active or
suppressed.
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WAO02

The number of points specified to define the water surface exceeds 40. The problem must be
either redefined so fewer points are used, or the dimensioning of the program must be increased to
accommodate the problem as defined.

WAO03

Only one point has been specified to define the water surface. A minimum of two points is
required.

WAO04

A negative coordinate has been specified for the water surface point indicated. All problem
geometry must be located within the 15t quadrant.

WAO05

The water surface point indicates that it is not to the right of the points specified prior to it The
points defining the water surface must be specified in left to right order.

R.6 SURFAC Error Codes
SFO1

The number of points specified to define a trial failure surface exceeds 100. The problem must
be either redefined so fewer points are used, or the dimensioning of the program must be increased to
accommodate the problem as defined.

SFO2

Only one points has been specified to define the trail failure surface. A minimum of two points
is required.

SFO3

A negative coordinate has been specified for the trial failure surface point indicated. All
problem geometry must be located within the first quadrant.

SFO4

The trial failure surface point indicated is not to the right of the points specified prior to fit. The
points defining the trial failure surface must be specified in left to right order, and no two points are
allowed to define a vertical line.
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SFO5

The first point specified for the trial failure surface is not within the horizontal extent of the
defined ground surface. All pint defining a trial failure surface must be within the horizontal extent of
the defined ground surface.

R.7 LIMIT Error Codes
LMO1

An attempt has been made to suppress or reactivate undefined surface generation boundary
data. Data must be defined by a prior us e of command LIMITS before they can be suppressed.
Suppressed data cannot be reactivated if command PROFIL has been used in the execution sequence
subsequent to their suppression. Command PROFIL nullifies all data read prior to their use whether the
data are active or suppressed.

LMO2

The number of surface generation boundaries specified to deflect upwards exceeds the total
number of boundaries specified. The number of upward deflecting boundaries must not exceed the
total number of boundaries.

LMO3

The number of surface generation boundaries specified exceeds 20. The problem must be
either redefined so fewer surface generation boundaries are used, or the dimensioning of the program
must be increased to accommodate the problem as defined.

LMO4

A negative coordinate has been specified for the surface generation boundary indicated. All problem
geometry must be located within the 15t quadrant.

LMO5

The coordinates of the end points of the surface generation boundary indicated have not been
specified in the required order. The coordinates of the left end point must precede those of the right.
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R.8 LOADS Error Codes
LDO1

An attempt has been made to suppress or reactive undefined surcharge boundary loads. Data
must be defined by a prior use of command LOADS before they can be suppressed. Suppressed data can
not be reactivated if command PROFIL has been used in the execution sequence subsequent to their
suppression. Command PROFIL nullifies all data read prior to their use, whether the data are active or
suppressed.

LDO2

The number of surcharge boundary loads specified exceeds 10. The problem must be either
redefines so fewer loads are used, or the dimensioning of the program must be increased to
accommodate the problem as defined.

LDO3

A negative coordinate has been specified for the surcharge boundary load indicated. All
problem geometry must be located within the first quadrant.

LDO4

The X coordinates defining the horizontal extend of the surcharge boundary load indicated have
not been specified in the required order. The X coordinate of the left end of the load must precede the
X coordinate of the right end.

LDO5

The surcharge boundary load indicated is not to the right of all the loads specified prior to it or
overlaps one or more of them. The loads must be specified left to right and are not allowed to overlap.

R.9 SOIL Error Codes
sLo1

The profile boundary indicated with the error message has an undefined soil type index. The
number of soil types specified must be greater than or equal to each soil type index which has been
assigned to profile boundaries.
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SLo2

The number of soil types may not exceed 20. The problem must be either redefined so fewer
soil types are used, or the dimensioning of the program must be increased to accommodate the
problem as defined.

SLO3

An attempt has been made to change the parameters of one or more soil types which are
undefined. No soil types have been defined since the last use of command PROFIL. When a new
problem is introduced by command PROFIL, the soil parameters, describing soil types of preceding
problems in the execution sequence, are no long available for use and cannot therefore be changed.

SLO4

The number of soil types to be changed is greater than the total number of soil types already
defined. This implies changing isotropic soil parameters of soil types which have not been specified and
therefore is not permitted. The number of soil types to be changed must be less than or equal to the
number of soil types specified by a previous use of command SOIL. Each soil type must be previously
specified, before its parameters may be changed.

SLO5

An attempt has been made to change the parameters describing an unspecified soil type. The
soil type must be defined before it may be modified. The index of each soil type to be changed must be
less than the total number of soil types.

R.10 ANISO Error Codes
Al01

An attempt has been made to suppress or reactivate undefined anisotropic strength data. Data
must be defined by a prior use of command ANISO before they can be suppressed. Suppressed data
cannot be reactivated if command PROFIL has been used in the execution sequence subsequent to their
suppression. Command PROFIL nullifies all data read prior to their use whether the data are active or
suppressed.

Al02

The number of anisotropic soil types specified may not exceed the number of soil types
specified by command SOIL.
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AlO3

The number of anisotropic soil types specified exceeds 5. The problem must be either redefined
so fewer anisotropic soil types are used, or the dimensioning of the program must be increased to
accommodate the problem as defined.

Alo4

The soil type index indicated is greater than the number of soil types specified by command
SOIL. The index of each anisotropic soil type must be less than or equal to the number of soil types
specified.

A105

The number of direction ranges specified for the anisotropic soil type indicated is less than 2 or
exceeds 10. No soil type should be defined anisotropic with number of direction ranges less than 2, as
this means soil is isotropic. Also no soil type should exceed 10 direction ranges. If this is desired, the
dimensions of the program must be increased.

A106

The counterclockwise limit of each direction range must be specified in counterclockwise order,
if the anisotropic strength is to be properly defined for the anisotropic soil type indicated.

A107

The total direction range for the anisotropic soil type indicated has not been completely
defined. The counterclockwise limit of the last direction range specified must be 90 degrees.

R.11 RANDOM and CIRCLE Error Codes

RCO1

The first initiation point lies to the left of the defined ground surface. The x coordinate of the
first initiation point must be specified so all trial failure surfaces generated will intersect the defined
ground surface when they initiate.

RCO2
The first and last initiation points are not correctly specified. They must be specified in left-right
order.

RCO3

The last initiation point lies to the right of the defined ground surface. The X-coordinate or the
last initiation point must be specified so all trial failure surfaces generated will intersect the defined
ground surface when they initiate.
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RCO4

The right termination limit lies to the right of the defined ground surface. The right termination
limit must be specified so all trial failure surfaces generated will intersect the defined ground surface
when they terminate.

RCO5
The left and right termination limits are not correctly specified. They must be specified in left-
right order.

RCO6

The last initiation point lies to the right of the right termination limit. It is impossible to
successfully generate any trial failure surfaces, when the initiation point lies to the right termination
limit.

RCO7

The depth limitation for trial failure surface development is negative. The depth limitation must
be set at or above the X-axis so the generated trial failure surfaces will not be allowed to develop below
it.

RC0O8
The length specified for the line segments used to generate trial failure surfaces is less than or
equal to zero. The length must be greater than zero.

RCO9
An initiation point is below the depth initiation. The depth limitation must be set lower to
enable the successful generation of trial failure surfaces from all initiation points.

RC10
The number Of points defining a generated trial failure surface exceeds 100. The length
specified for the line segments must be increased.

RC11

200 attempts to generate a single trial failure surface have railed. The search limitations are
either too restrictive, or they actually prevent successful generation of a trial failure surface from one or
more of the initiation points. Check and revise the search limitations or use an alternative trial surface
generator.

RC12

Fewer than 10 trial surfaces have been specified to be generated. A minimum of 10 must be
generated
RC13

The angle specified as clockwise direction limit for surface generation is larger than the angle
specified as counterclockwise direction limit. This is not correct. Check to see if angles have been
reversed.

RC16
The choice of using Janbu’s empirical coefficient (0 or 1) was incorrectly done.
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RC17
If the Janbu empirical coefficient is being used, the soil case was chosen incorrectly. i.e.. not
equal to one of the following integers 1, 2, 3.

R.12 BLOCK Error Codes

BKO1

The number of boxes specified for a sliding block search exceeds 10. The problem must be either
redefined so fewer points are used, or the dimensioning of the program must be increased to
accommodate the problem as defined.

BKO2
The length specified for the line segments used to generate the active and passive portions of
the trial failure surfaces is less than or equal to zero. The length must be greater than zero.

BKO3
The two coordinate points specified to define the centerline of the box indicated have not been
specified correctly. The left point must be specified first.

BKO4
The box indicated and the one specified before it are not properly ordered, or they overlap. All
boxes must be specified in left to right order and the boxes are not allowed to overlap one another.

BKO5
The box indicated is wholly or partially defined outside of the 1st quadrant. All problem
geometry must be located within the 1st quadrant.

BKO6

The box indicated is wholly or partially above the defined ground surface. Each box must be
defined totally below the ground surface.
BKO7

It is not possible to complete the active portion of the failure surface from part of or all of the
last box specified. The last box specified must be entirely to the left of the right end of the defined
ground surface.

BK08

It is not possible to complete the passive portion of the failure surface from part of or all of the
first box specified. The first box specified must be entirely to the right of a fictitious line extended
downward at forty-five deg with the horizontal from the left end of the defined ground surface.

BK09

The number of points defining a generated trial failure surface exceeds 100. The length specified
for the line segments of the active and passive portions of the generated trial failure surfaces must be
increased.
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BK10

200 attempts to generate a single trial failure surface have failed.
The search limitations are either too restrictive or they actually prevent successful generation of a trial
failure surface. Check and revise the search limitations or use an alternate trial surface generator.

BK11
Fewer than 10 trial failure surfaces have been specified to be generated. A minimum of 10 must
be generated.

BKI2

The point(s) calculated on active or passive portion of the sliding block is not within the
horizontal extent of the defined ground surface. Either the specified boxes should be changed or the
geometry of the problem should be extended to include the point(s) in question.

BK16
The choice of using Janbu’s empirical coefficient (0 or 1) was incorrectly done.

BK17
If the Janbu empirical coefficient is being used, the soil case was chosen incorrectly, i.e., not
equal to one of the following integers 1, 2, 3.

R.13 TIES Error Codes

TIO1

An attempt has been made to suppress or reactivate undefined tieback loads. Data must be
defined by a prior use of command TIES before they can be suppressed. Suppressed data can not be
reactivated if command PROFIL has been used in the execution sequence subsequent to their use.
whether the data are active or suppressed.

TIO2

The number of tieback loads specified exceeds 10. The problem must either be redefined so
fewer tieback loads are used, or dimensioning of the program must be increased to accommodate the
problem as defined.

TI03

A negative coordinate has been specified for the tieback load indicated or the calculated Y
coordinate of the end of the tieback is negative. All problem geometry must be located within the first
quadrant.

TIO4

The inclination limits have been exceeded for the tieback load indicated. The inclination of a
tieback load must be equal to or greater than zero deg and less than 180 deg as measured clockwise
from the horizontal.

User’s Manual (Rel. October/2015) STABLPRO for Windows

COPYRIGHT © ENSOFT, INC 2015
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTORIZATION FROM ENSOFT, INC



List of Technical References — R-14

T105

The point of application of the tieback load specified does not lie on the ground surface
boundary specified. Check the boundary Lumber specified and the X and Y coordinates of the point of
application of the tieback load indicated.

T106
The horizontal spacing between tiebacks for the row of tieback is indicated is incorrect. The
horizontal spacing between tiebacks must be greater than or equal to 1 ft (or 1 meter if using Sl units).

T107
The length of the tieback indicated is incorrect. The length of a tieback must be greater than or
equal to zero (ft). Zero is used for loads other than tieback type of loads.

R.14 SPENCR Error Codes

SP01
An incorrect value for the approximate slope angle has been specified. The slope angle specified
must be greater than zero (deg) and less than 90 (deg).
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License Agreement & Disclaimer
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PROGRAM LICENSE AGREEMENT & DISCLAIMER

IMPORTANT NOTICE: This License Agreement & Disclaimer ("LICENSE") is a legal agreement
between you (either an individual or a single entity) and Ensoft Incorporated (ENSOFT) for the ENSOFT
product (“PRODUCT”) identified on the current installation screen. The PRODUCT includes computer
software and associated media, printed materials, hardware key (dongle), and electronic documentation.
The PRODUCT also includes any updates and supplements to the original PRODUCT that may have been
produced by ENSOFT. By installing, copying, downloading, accessing or otherwise using the PRODUCT,
you agree to be bound by the terms of this LICENSE. If you do not agree to the terms of this LICENSE, do
not install or use the PRODUCT.

SOFTWARE LICENSE & DISCLAIMER

The PRODUCT is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The PRODUCT is licensed, not sold.

1. GRANT OF LICENSE
This LICENSE grants you the following rights:

1.1 INSTALLATION AND USE
1.1.1 Single-User Licenses

This software is licensed only to the user (company or individual) whose name is registered with ENSOFT
and for one specific physical site (“SITE”) registered with ENSOFT. You may install and use the
PRODUCT on any number of computers at the licensed SITE. However, the PRODUCT is fully
operational only in the licensed site computer that carries the appropriate PRODUCT’s hardware key
(“KEY”) that is used as software protection device.

1.1.2 Network Licenses

This software is licensed only to the user (company or individual) whose name is registered with ENSOFT
and for the specific physical site(s) (“SITE(S)”) and IP range registered with ENSOFT. Each network
license is provided up to two client IP ranges with unique third octets (Class C or equivalent) for each seat
(user count). The minimum 2-seat local network license can be associated to a maximum of four client IP
ranges with unique third octets (Class C or equivalent).

You may install and use the PRODUCT on any computer in the licensed SITE(S) that is within the
allowable IP range registered with ENSOFT. Any one computer in the network can be designated as
software server for the PRODUCT by carrying the appropriate PRODUCT’s hardware key (“KEY™) that is
used as software protection device.

This Network License strictly prohibits the PRODUCT to be used in or from computers located in office
locations that are different than the licensed SITE(S) or outside the registered IP range. Users in physical
office locations other than the registered SITE(S) with ENSOFT are required to purchase additional
licenses of the PRODUCT, even if the user name (company or individual) is the same and/or if the
additional offices are located in the same city.

2. OTHER RIGHTS AND LIMITATIONS
2.1 EDUCATIONAL VERSION

If the PRODUCT was sold with educational discounts, the use of the PRODUCT is strictly limited to
academic or research activities of educators and/or students. Any other usage voids all the rights under this
LICENSE. If in doubt, please contact ENSOFT to determine if you have a PRODUCT version that was
sold for educational purposes.
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2.2 LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY

You may not reverse engineer, decompile, or disassemble the PRODUCT, except and only to the extent
that such activity is expressly permitted by applicable law notwithstanding this limitation.

2.3 RENTAL
You may not rent, lease or lend the PRODUCT.
2.4 TRADEMARKS

This LICENSE does not grant you any rights in connection with any trademarks or service marks of
ENSOFT.

2.5 SUPPORT SERVICES

ENSOFT may provide you with support services (“SUPPORT”) related to the PRODUCT. Use of
SUPPORT is limited to the ENSOFT policies and programs described in the PRODUCT’s User Manual, in
documentation on the ENSOFT web site, and/or other materials provided by ENSOFT.

Any supplemental software code that may be provided to you as part of the SUPPORT or that is
downloaded from the ENSOFT web site shall be considered part of the PRODUCT and subject to the terms
and conditions of this LICENSE. With respect to technical information you provide to ENSOFT as part of
the SUPPORT, ENSOFT may use such information for its business purposes, including for product
support, development or advertisements. However, ENSOFT will not utilize such technical information in
a form that personally identifies the user.

2.6 SOFTWARE TRANSFER

The initial user of the PRODUCT may make a one-time permanent transfer of this LICENSE and
PRODUCT and only directly to an end user. This transfer must include all of the PRODUCT (including all
component parts, the media and printed materials, any upgrades, this LICENSE, and the PRODUCT’s
appropriate hardware lock). Such transfer may not be by way of consignment or any other indirect transfer.
The transferee of such one-time transfer must agree to comply with the terms of this LICENSE, including
the obligation not to further transfer this LICENSE and PRODUCT.

2.7 TERMINATION

Without prejudice to any other rights, ENSOFT may terminate this LICENSE if you fail to comply with the
terms and conditions of this LICENSE. In such event, you must destroy all copies of the PRODUCT and
all of its component parts.

3. COPYRIGHT

All title and intellectual property rights in and to the PRODUCT (including but not limited to any images,
photographs, animations, video, audio, music, and text that may be incorporated into the PRODUCT), the
accompanying printed materials, and any copies of the PRODUCT are owned by ENSOFT. All title and
intellectual property rights in and to the content which may be accessed through use of the PRODUCT is
the property of the respective content owner and may be protected by applicable copyright or other
intellectual property laws and treaties. This LICENSE grants you no rights to use such content. All rights
not expressly granted are reserved by ENSOFT. This PRODUCT is protected by the United States
Copyright Law and International Copyright Treaty.

4. SOFTWARE DISCLAIMER

Although the PRODUCT has been used with apparent success in many analyses, new information is
developed continuously and new or updated PRODUCT releases may be written from time to time. All
users are requested to inform ENSOFT immediately if any errors are found in the PRODUCT. As
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modifications, updates, or new versions are produced, the latest codes are posted on ENSOFT’s web site
and made available to all visitors for free downloading.

No warranty, expressed or implied, is offered as to the accuracy of results from ENSOFT’s PRODUCT.
The PRODUCT should not be used for design unless caution is exercised in interpreting the results and
independent calculations are available to verify the general correctness of the results. Users are assumed to
be knowledgeable of the information in the printed documentation that is distributed with the digital media.
Users are assumed to recognize that the input parameters, eg., soil properties, increment length, tolerance
on solution convergence, and many others, can have a significant effect on the solution and must be chosen
carefully. Users should have a thorough understanding of the relevant theoretical criteria (appropriate
references are suggested in the software documentation).

5. MISCELLANEOUS

If you acquired this product in the United States of America, this LICENSE is governed by the laws of the
State of Texas.

If this product was acquired outside the United States, then local law may apply.

Should you have any questions concerning this LICENSE, or if you desire to contact ENSOFT for any
reason, please use the following:
Ensoft Incorporated
3003 West Howard Lane
Austin, Texas 78728
United States of America

NO OTHER WARRANTIES

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ENSOFT DISCLAIMS ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT, WITH REGARD TO THE
PRODUCT, AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. THIS
LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS,
WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION.

LIMITATION OF LIABILITY

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
ENSOFT BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY
OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE
SOFTWARE PRODUCT OR THE FAILURE TO PROVIDE SUPPORT, EVEN IF ENSOFT HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, ENSOFT’S ENTIRE
LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT SHALL BE LIMITED TO
THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU FOR THE PRODUCT OR U.S.$1.00.
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